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MOTTO 

“Jika kamu berbuat baik (berarti) kamu berbuat baik bagi dirimu sendiri dan 

jika kamu berbuat jahat, maka (kejahatan) itu bagi dirimu sendiri” 

(Q.S Al-Isra’ :7) 

 

“Wherever you are, be a person who benefits others” 

~.~ 

  



 

ABSTRAK 

Indonesia termasuk kedalam daerah yang rawan bencana gempa bumi 

karena dikelilingi oleh cincin api pasifik (Ring of fire) dan berada pada wilayah 

pertemuan tiga lempeng tektonik, sehingga perlu adanya upaya untuk 

meminimalisir kerusakan akibat gempa, salah satunya adalah dengan menggunakan 

base isolator system. Penelitian bertujuan untuk mengetahui pengaruh penggunaan 

base isolator dengan tipe High Dumping Rubber Bearing (HDRB) terhadap 

perilaku struktur beton bertulang pada bangunan tinggi akibat beban gempa. 

Struktur bangunan yang digunakan sebagai lokasi penelitian yaitu Gedung 

Sapadia Hotel dengan 7 lantai di kota Mataram. Penelitian dilakukan dengan 

menganalisis model tiga dimensi pada struktur fixed base dan struktur base isolator 

dengan menggunakan aplikasi ETABS v.18, kemudian dilakukan perbandingan 

hasil analisis berupa periode getar, gaya geser dasar, simpangan, simpangan antar 

lantai dan level kinerja struktur dari kedua model.  

Berdasarkan hasil analisis, penggunaan base isolator tipe High Damping 

Rubber Bearing (HDRB) dengan diameter 800 mm dan nominal long term column 

load sebesar 6050 kN dapat meningkatkan nilai periode getar dari 1,960 detik 

menjadi 3,204 detik. Terjadi peningkatan simpangan dasar pada struktur base 

isolator sebesar 59% arah x dan 44% arah y, sebaliknya simpangan antar lantai 

mengalami penurunan sebesar 36% arah x dan 69% arah y. Penggunaan base 

isolator dapat mereduksi gaya geser dasar dari 1926,48 kN menjadi 1248,086 kN 

arah x dan 1248,068 kN menjadi 1060,645 kN arah y. Berdasarkan hasil analisis 

pushover diperoleh nilai simpangan atap pada struktur fixed base dan base isolator 

berturut-turut sebesar 0,159 m dan 0,129 m. Nilai tersebut dapat digunakan untuk 

menentukan level kinerja struktur berdasarkan Applied Technology Council 40 

(ATC-40), didapatkan nilai drift max pada struktur fixed base sebesar 0,0055 m, 

sehingga termasuk ke dalam kategori Immediate Occupancy (IO). Pada struktur 

base isolator nilai drift max sebesar 0,0044 m, sehingga termasuk ke dalam kategori 

Immediate Occupancy (IO). Artinya kerusakan pasca gempa yang terjadi pada 

struktur sangat sedikit serta risiko adanya korban jiwa sangat kecil dan bangunan 

masih aman untuk tetap digunakan. 

 

Kata kunci: gempa, base isolator, high damping rubber bearing, pushover.  
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ABSTRACT 

Indonesia is located in an earthquake-prone region ue io its posilion 
withn the Pacific Ring of Fire and at the comvergence of three tectonic plates. 
Using foundation isolator systems is one of the measures 1hat can he taken to 
migate earthquake damage. This study examines the influence of High Damping 
Rubber Bearng (HDRB) base isolators on ihe seismic hehavior of reinforced 
concrete structures in high-rise buildings. 

The westigation was conducted on the seven-siory Sapadia Hotel 
bunld1mg in Malaram. Using ETABS v.18 sofware, a comparison was made 
between a three-dimensional model of a fixed base structure and a base isolator 
structure. The two models were compared regarding their analysis outcomes, 
which inchuded vibration period, base shear force, displacement, inter-story drifi, 
and structural performance level. 

Based on the analysis, HDRB base isolators with a diameier of 800 mm 
and a nominal long-term column load of 6050 kN increased the vibration period 
from 1.960 seconds to 3.204 seconds. The base displacement in the base isolator 
structure increased by 59% in the x-direction and 44% in the y-direction, while 
the inter-story drift decreased by 369% in the x-direction and 69% in the y 
direction. Using base isolators reduced the base shear force from 1926.48 kN to 
1248.086 kN in the x-direction and from 1248.068 kN to 1060.645 kN in the y 
direction. Based on the pushover analysis, the roof displacement in the structure 
with a fxed base was 0.159 m, while it was 0.129 m in the structure with a base 
isolator. According to Applied Technology Council 40 (ATC-40), these values 
were used to determine the structural performance level. The maximum drifi value 
in the fixed base structure was 0.0055 m, corresponding lo the Immediate 
Occupancy (10) performance level. The maximum drift value in the base isolator 
structure was 0.0044 m, also classified as Immediate Occupancy (10). I indicates 
minimal post-earthquake damage to the structure, the risk of casualties is very 
low, and the building is safe for contiued use. 

Keywords: earthquake, base isolator, high damping rubber bearing, pushover. 
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BAB I 

PENDAHULUAN 

1.1 Latar Belakang 

Indonesia termasuk kedalam daerah yang rawan bencana gempa bumi 

karena dikelilingi oleh cincin api pasifik (Ring of fire) dan berada pada wilayah 

pertemuan tiga lempeng tektonik yaitu lempeng Indo-Australia, Eurasia dan 

lempeng pasifik. Hal inilah yang menyebabkan wilayah Indonesia sering 

mengalami bencana gempa bumi. Menurut data yang dikeluarkan Badan Geologi 

Kementerian Energi dan Sumber Daya Mineral (ESDM) pada tahun 2018 terjadi 

14 gempa bumi dan pada tahun 2021 juga terjadi 26 gempa bumi dengan daya rusak 

signifikan, gempa bumi pada tahun 2021 merupakan kejadian gempa bumi tertinggi 

dalam kurun 20 tahun terakhir (Supartoyo, 2022). Disamping itu, pulau Lombok 

menjadi salah satu kepulauan di Indonesia yang secara tektonik merupakan 

kawasan seismik aktif. Pulau Lombok terletak diantara dua pembangkit gempa 

yaitu, zona subduksi Indo-Australia dari arah selatan dan terdapat struktur geologi 

sesar naik flores dari arah utara. 

Pulau Lombok kerap menjadi lokasi gempa besar. Gempa yang terjadi pada 

tanggal 29 Juli 2018 di pulau Lombok ini berkekuatan 6,4 Skala Richter dan disusul 

dengan kekuatan 7,0 Skala Richter pada tanggal 5 Agustus 2018. Gempa ini 

menimbulkan kerusakan bangunan, fasilitas umum dan banyaknya korban jiwa. 

Kota Mataram yang menjadi pusat kota di pulau Lombok juga terkena dampak dari 

gempa bumi ini. Berada di wilayah risiko kegempaan 4 membuat kota Mataram 

memiliki risiko yang sangat besar terhadap kerusakan infrastruktur gedung yang 

cukup parah akibat gempa.  

Rusaknya gedung menimbulkan kerugian secara moril dan material, 

umumnya menyebabkan korban jiwa akibat tertimpa bangunan yang runtuh pada 

saat gempa. Gempa bumi tidak dapat dipungkiri untuk dicegah terjadinya, namun 

perlu adanya upaya untuk meminimalisir kerusakan akibat gempa. Berbagai upaya 

telah dilakukan untuk meminimalisir dampak gempa bumi terhadap struktur 

bangunan dengan mengembangkan bangunan tahan gempa, mulai dengan membuat 

dinding geser (Shear Wall) hingga menambahkan perkuatan dengan sistem pengaku 
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(Bracing). Namun seiring perkembangan zaman, dikembangkanlah inovasi untuk 

melakukan proteksi bangunan gedung terhadap gempa yang lebih efisien yaitu Base 

Isolator. Negara dengan risiko tinggi terhadap gempa seperti Jepang, Turki, Italy, 

Portugal, USA, Iran, China, Selandia Baru, dan Taiwan telah banyak menggunakan 

base isolator ini. 

Base isolator ini memiliki konsep yaitu memisahkan struktur atas dengan 

struktur bawah yang bekerja dengan menjaga struktur diatasnya sebagai satu 

kesatuan, arah getaran gempa yang terjadi secara acak hanya akan mempengaruhi 

base isolator karena base isolator ini sifatnya elastis, sedangkan struktur diatasnya 

akan bergetar atau bergerak sebagai satu kesatuan struktur (Lesmana, 2013). 

Keunggulan dari penggunaan base isolator dibandingkan dengan struktur bangunan 

tahan gempa yang lain adalah mampu mereduksi gaya gempa yang terjadi dari 

struktur bawah ke struktur atas bangunan dan base isolator ini juga mampu 

memperkecil nilai displacement dan drift pada setiap lantai struktur bangunan. Ada 

banyak sistem isolasi yang digunakan pada base isolator, namun pada penelitian 

ini akan digunakan base isolator dengan tipe High Dumping Rubber Bearing 

(HDRB).  

Penerapan base isolator sendiri belum ada ditemukan pada struktur 

bangunan di pulau Lombok khususnya di kota Mataram, sehingga perlu dipelajari 

dan diteliti untuk mengaplikasikan sistem tersebut dalam menjamin kemampuan 

struktur bangunan di kota Mataram untuk meminimalisir efek dari gempa bumi 

yang terjadi. Salah satu bangunan di kota Mataram menjadi tempat dilakukannya 

penelitian yaitu gedung Sapadia Hotel yang stuktur bangunannya masih 

menggunakan beton bertulang dengan Sistem Rangka Pemikul Momen Khusus 

tanpa adanya peredam gempa, sehingga diperlukan adanya proteksi terhadap 

gempa. Mengacu dari permasalahan tersebut, penulis memiliki inovasi dengan 

melakukan penelitian yang bertujuan untuk menganalisis Penggunaan base isolator 

dengan Tipe High Dumping Rubber Bearing (HDRB) pada bangunan Sapadia 

Hotel, yang tentunya dengan menerapkan peraturan Standar Nasional Indonesia 

yang berlaku dengan benar. 
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1.2 Rumusan Masalah 

Berdasarkan latar belakang diatas, ada beberapa permasalahan yang dapat 

ditarik untuk penyusunan tugas akhir ini:  

1. Bagaimana pengaruh penggunaan base isolator dengan tipe High Dumping 

Rubber Bearing (HDRB) terhadap perilaku struktur beton bertulang pada 

bangunan tinggi akibat beban gempa? 

2. Bagaimana base shear, displacement, dan drift pada struktur bangunan yang 

menggunakan fixed base dengan sistem struktur base isolator pada gedung 

Sapadia Hotel? 

3. Bagaimana perbandingan momen dan gaya geser pada struktur gedung yang 

menggunakan struktur fixed base dengan struktur base isolator pada gedung 

Sapadia Hotel? 

4. Bagaimana level kinerja struktur gedung fixed base dengan struktur base 

isolator gedung Sapadia Hotel berdasarkan ATC-40 menggunakan analisa 

pushover? 

 

1.3 Tujuan Penelitian 

Berdasarkan rumusan masalah diatas, tujuan utama dari penelitian ini adalah 

sebagai berikut: 

1. Mengetahui perilaku struktur akibat penggunaan base isolator pada beton 

bertulang bangunan tinggi akibat beban gempa. 

2. Mengetahui perbandingan base shear, displacement, dan drift pada struktur 

bangunan yang menggunakan fixed base dengan sistem struktur base isolator 

pada gedung Sapadia Hotel. 

3. Mengetahui perbandingan momen dan gaya geser pada struktur primer gedung 

yang menggunakan struktur fixed base dengan struktur base isolator pada 

gedung Sapadia Hotel. 

4. Mengetahui level kinerja struktur gedung fixed base dengan struktur base 

isolator gedung Sapadia Hotel berdasarkan ATC-40 menggunakan analisa 

pushover. 
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1.4 Batasan Masalah 

Adapun batasan masalah yang digunakan dalam penelitian agar lebih 

terkendali dan relevan dengan apa yang ingin dibuktikan adalah: 

1. Bangunan gedung yang ditinjau berfungsi sebagai Hotel. 

2. Lokasi penelitian terletak di Gedung Sapadia Hotel. 

3. Bangunan terdiri dari 7 lantai dengan ketinggian 29 m. 

4. Peraturan beton menggunakan SNI 2847-2019. 

5. Pembebanan gempa menggunakan SNI 1726-2019. 

6. Tipe base isolator adalah High Dumping Rubber Bearing. 

7. Program yang digunakan untuk analisis struktur adalah ETABS v.18. 

8. Level kinerja menggunakan metode pushover berdasarkan ATC-40. 

9. Tidak membahas biaya dan metode pelaksanaan konstruksi. 

10. Tidak membahas perhitungan sambungan base isolator dengan kolom. 

11. Tidak membahas penulangan struktur. 
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BAB II 

TINJAUAN PUSTAKA DAN LANDASAN TEORI 

2.1 Tinjauan Pustaka 

Pada penelitian ini mengacu pada penelitian-penelitian sebelumnya dan 

peraturan-peraturan yang berlaku. Syahnandito et.al (2020). Penelitian yang 

dilakukan dengan judul Pengaruh Penggunaan Base Isolation High Damping 

Rubber Bearing pada Struktur Beton Bertulang. Adapun permasalahan yang 

didapatkan adalah belum ditemukannya struktur bangunan bertingkat yang 

mengaplikasikan isolasi karet yang dapat menjamin struktur bangunan dari gempa 

di daerahnya. Parameter yang digunakan diantaranya Beban mati, beban mati 

tambahan, beban sendiri struktur, beban hidup dan beban gempa dengan 

penggunaan metode Base Isolation System. Hasil analisa dari penelitian ini 

didapatkan periode struktur fix base sebesar 4,212 detik, gaya geser dasar 

didapatkan sebesar 1470,725 ton. Sedangkan pada struktur dengan base isolation 

berdasarkan hasil analisa didapatkan periode sebesar 5,500 detik, dengan gaya 

geser dasar didapatkan sebesar 1286,071 ton. Maka dapat disimpulkan bahwa pada 

struktur dengan base isolation terjadi peningkatan periode sebesar 30,58%, 

sedangkan gaya geser dasar terjadi penurunan 12,56%. 

Samsya (2017). Melakukan penelitian dengan judul Evaluasi Aplikasi 

Penggunaan Base Isolation Pada Gedung Grand Keisha Menggunakan Analisa 

Pushover. Pada penelitian tersebut membahas perbandingan struktur fixbase 

dengan struktur base isolation dengan tipe High Damping Rubber Bearing. 

penelitian ini bertujuan untuk mengetahui sejauh mana base isolation dapat bekerja 

terhadap perilaku bangunan. Studi kasus yang digunakan adalah Hotel Grand 

Keisha terletak di Padang yang zona gempanya merupakan gempa tinggi. 

Dilakukan analisa pushover untuk mengetahui kinerja struktur jika terkena gempa. 

Dari analisa yang dilakukan, base isolation didapatkan peningkatan nilai gaya geser 

sistem struktur isolasi terhadap system struktur fixbase sebesar 20,12%. 

Displacement pada struktur base isolation dan fixbase mengalami penurunan, 

sesuai dengan gempa dinamik yang ditinjau sebesar 89,86% (arah x) dan 88,79% 

(arah y). Nilai simpangan horizontal (Drift) pada struktur base isolation dan 
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struktur fixbase mengalami reduksi sebesar 63,63% (arah x) dan 68,18% (arah y). 

Didapatkan level kinerja struktur kategori B (Operasional) pada struktur base 

isolation, yang artinya tidak ada kerusakan berarti pada struktur dan non-struktur, 

dengan kata lain bangunan tetap berfungsi. Pada struktur fixbase didapatkan level 

kinerja struktur dengan kategori IO (Immediate Occupancy), yang berarti 

komponen non struktur masih berada ditempatnya dan jika utilitasnya masih 

tersedia maka komponen tersebut masih berfungsi. 

 

2.2 Landasan Teori 

2.2.1 Modulus elastisitas 

Modulus elastisitas digunakan untuk mengetahui seberapa besar rasio objek 

tersebut dapat berubah (deformasi elastis) ketika mengalami tekanan atau regangan. 

Material beton dan baja dapat mengalami deformasi elastis sehingga perlu diketahui 

Modulus elastisitasnya. Modulus elastisitas baja ditentukan berdasarkan SNI 

1729:2020 Pasal B4 Tabel B4.1b sebesar 200.000 MPa dan modulus elastisitas 

beton dihitung dengan persamaan 2.1. 

𝐸 = 4700 𝑥 √𝐹′𝑐   ...............................................................................  (2.1) 

Dengan:  

F’c = Kuat tekan beton 

E = Modulus elastisitas 

2.2.2 Preliminary desain 

a. Preliminary pelat 

Pelat adalah suatu elemen struktural yang membentuk permukaan datar secara 

horizontal yang dapat menerima beban mati maupun beban hidup kemudian 

menyalurkannya menuju balok, pelat ini biasanya diaplikasikan pada lantai dan 

atap dak. Pelat beton bidang horizontal yang terbuat dari campuran pasir, 

semen, air, kerikil dan admixture. Pelat ini memiliki ketebalan jauh lebih kecil 

dari balok, hal ini karna pelat hanya menahan beban mati dan hidup. Ketebalan 

dari pelat biasanya 12 cm sampai 15 cm tergantung beban yang dipikul. Karna 

berada pada lantai maka, elemen ini perlu didukung oleh rangka balok dan 
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kolom di bawahnya. Struktur balok dan pelat biasanya dicor secara bersamaan 

dengan tujuan untuk menghasilkan suatu kesatuan struktur yang monolit, 

sehingga bisa diasumsikan sebagai difragma. Pada skripsi ini digunakan pelat 

dua arah, yaitu pelat dengan tulangan pokok dua arah yang digunakan apabila 

panjang/lebar bentang pelat kurang dari 2 (L/W < 2). Ketebalan minimum dari 

pelat dua arah nonprategang dengan balok diantara tumpuan semua sisinya 

dapat dihitung berdasarkan Tabel 2.1 Ketebalan minimum pelat dua arah 

nonprategang. 

 

Tabel 2.1 Ketebalan minimum pelat dua arah nonprategang 

fy, 
MPa 

Tanpa drop panel 
Panel eksterior 

Panel interior 
Tanpa balok tepi Dengan balok tepi 

280 Ln/33 Ln/36 Ln/36 
420 Ln/30 Ln/33 Ln/33 
520 Ln/28 Ln/31 Ln/31 

(Sumber: SNI 2847:2019) 

 

b. Preliminary balok 

Balok adalah komponen portal dengan bentang horizontal. Adapun beban yang 

bekerja pada balok biasanya berupa beban geser, beban lentur, dan momen 

punter (torsi), sehingga untuk menahan beban tersebut dibutuhkan baja 

tulangan. Tulangan ini berupa tulangan longitudinal atau tulangan memanjang 

yang akan menahan beban lentur, serta tulangan geser atau begel yang akan 

menahan beban torsi dan geser (Asroni, 2010). Untuk preliminary balok 

biasanya ditentukan oleh arsitek. Namun untuk menentukan desain yang aman 

biasanya mengacu pada Tabel 2.2 Tinggi minimum balok nonprategang. 

 

Tabel 2.2 Tinggi minimum balok nonprategang 

Kondisi perletakan Tinggi minimum (hmin) 
Perletakan sederhana L/16 

Menerus satu sisi L/18,5 
Menerus dua sisi L/21 

Kantilever L/8 
(Sumber: SNI 2847:2019) 



 

8 
 

 
Catatan: Rumusan tabel diatas dapat digunakan pada beton mutu normal dan 

tulangan mutu 420 MPa. Untuk mutu baja tulangan diatas 420 MPa, tinggi 

minimum pada tabel diatas harus dikalikan dengan Persamaan 2.2. 

(0,4 + fy / 700) ............................................................................... (2.2) 

Dengan: 

Fy = Kuat leleh baja tulangan 

c. Preliminary kolom 

Kolom berfungsi sebagai pendukung untuk menerima beban dari balok dan 

pelat yang kemudian akan diteruskan menuju tanah dasar melalui pondasi. 

Beban yang ditimbulkan oleh balok dan pelat ini berupa beban tekan aksial dan 

momen lentur (akibat kontinuitas konstruksi). Oleh karena itu, kolom dapat 

didefinisikan sebagai suatu struktur yang memikul beban aksial dengan/tanpa 

momen lentur (Asroni, 2010). 

Desain awal kolom bisa dihitung dengan Persamaan 2.3 dan Persamaan 2.4: 

b kolom = b balok terbesar + 100 ................................................. (2.3) 

h kolom = b kolom x
ቀ

ౌ ౪౥౪౗ౢ ౘ౗౤ౝ౫౤౗౤

ౠ౫ౣౢ౗౞ ౦౟౗౩
ቁ ୶ ୬ ୫ୣ୪୧୬୲ୟ୬୥

ቀ
ై ౪౥౪౗ౢ ౘ౗౤ౝ౫౤౗౤

ౠ౫ౣౢ౗౞ ౦౟౗౩
ቁ ୶ ୬ ୫ୣ୫ୟ୬୨ୟ୬୥

  ....................... (2.4) 

Dengan:  

b  = Lebar elemen struktur 

h  = Tinggi elemen struktur 

P  = Panjang bangunan 

L = Lebar bangunan 

n  = Jumlah pias 

2.2.3 Pembebanan 

Berdasarkan SNI 1727:2020 tentang beban minimum untuk perancangan 

bangunan bangunan Gedung dan struktur lain. Beban yang bekerja pada Gedung 

terdiri dari beban hidup, beban mati (berat struktur sendiri), dan beban mati 

tambahan (berat elemen non struktural). 
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1. Beban mati (Dead load) 

Beban mati adalah berat seluruh bahan konstruksi bangunan gedung yang 

terpasang, baik itu komponen struktural maupun komponen arsitektural beserta 

peralatan layan terpasang lain termasuk berat derek dan sistem pengangkut 

material. Untuk berat masing-masing material penyusun elemen struktural 

dilihat pada Tabel 2.3 Rekapitulasi beban Mati (Dead Load). 

 
Tabel 2.3 Rekapitulasi beban Mati (Dead Load) 

Material 
Berat Volume 

kN/m3 kg/m3 

Beton (tidak bertulang) 22 2200 

Beton bertulang 24 -25 2400 - 2500 

Baja 78,5 7850 

Mata merah 17 1700 

Adukan semen 20 - 21 2000 - 2100 

Air 10 1000 

Tanah (umum) 17 - 18 1700 - 1800 

Pasir kering 16 1600 

Pasir jenuh 18 1800 

Kayu (klas I) 10 1000 

Aspal 14 1400 
(Sumber: SNI 1727:2020) 

 
2. Beban mati tambahan (Super imposed dead load) 

Beban mati tambahan atau super imposed dead load adalah berat komponen 

non struktural yang terdapat pada struktur bangunan. Untuk berat mati 

tambahan bisa di lihat pada Tabel 2.4 Rekapitulasi beban mati tambahan. 
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Tabel 2.4 Rekapitulasi beban mati tambahan 

Material 
Berat Volume 

kN/m3 kg/m3 

Atap:     

Genteng keramik (reng + kasau) 0,5 50 

Plafon, ceilling, langit-langit 0,18 18 

Atap metal 1mm (reng + kasau) 0,1 10 

Dek Beton (screed)     

Keramik (+ screed/adukan semen) 1,5 150 

Raised floor (+ carpet) 0,2 20 

Dinding:     

Batako tanpa lubang, t 15 cm 3 300 

Hebel 10 cm + render 1 100 

Hebel 12.5 cm + render 1,2 120 

Celcon 10 cm + render 1,5 150 

Celcon 12.5 cm + render 1,7 170 

(Sumber: SNI 1727:2020) 

 
Dalam penelitian ini, model juga memiliki akses lift dimana lift adalah 

transportasi vertikal pada gedung yang berfungsi untuk mengangkut orang atau 

barang. Lift umumnya digunakan pada gedung-gedung bertingkat banyak yang 

biasanya lebih dari tiga atau empat lantai. Bangunan yang lebih rendah 

biasanya hanya menggunakan tangga atau eskalator. Lift-lift di zaman modern 

mempunyai tombol penunjuk lantai yang dapat dipilih penggunanya sesuai 

lantai tujuan. Dalam sistem penggerak lift ada tiga jenis mesin, yaitu Hidraulic, 

Traction, dan Hoist. Dalam penelitian ini digunakan lift dengan sistem tanpa 

ruang mesin seperti Gambar 2.1. 
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Gambar 2.1 Lift tanpa ruang mesin 

(Sumber: Aoyama, 2023) 

 
3. Beban hidup (Live load) 

Beban hidup atau live load adalah beban yang berasal dari penghunian atau 

penggunaan gedung seperti dari barang atau orang yang dapat berpindah tempat 

sehingga mengakibatkan perubahan dalam pembebanan lantai dan atap. Beban 

hidup terdistribusi merata minimal, Lo dan beban hidup terpusat minimal bisa 

di lihat pada tabel 2.5 Rekapitulasi beban hidup. 

 
Tabel 2.5 Rekapitulasi beban hidup 

Jenis beban hidup Berat (kN/m2) 

Beban hidup ruang kantor 2,40 

Beban hidup ruang computer 4,79 

Beban hidup ruang operasi, Laboratorium 2,87 

Helipad, Helikopter dengan berat lepas landas lebih 

dari 3000 Lb (13,35 kN) 
2,87 

Beban hidup koridor  diatas lantai pertama 3,83 

Ruang penyimpanan 7,18 

Beban hidup tangga 4,79 

Beban hidup dak 0,96 

Beban hidup ruang pertemuan 4,79 

Beban hidup lantai parkir 1,92 

(Sumber: SNI 1727:2020) 

 



 

12 
 

2.2.4 Kombinasi pembebanan 

Berdasarkan SNI 1727:2020 bahwa struktur, komponen-elemen struktur 

atas maupun bawah harus di desain hingga kuat rencana atau bahkan melebihi dari 

pembebanan terfaktor dengan kombinasi-kombinasi yang sesuai dengan Persamaan 

2.5 sampai dengan Persamaan 2.12 dan untuk penjabarannya dapat dilihat pada 

Tabel 2.6 Kombinasi pembebanan analisis struktur: 

1,4D  ...................................................................................................  (2.5) 

1,2D + 1,6L + 0,5(Lr atau R) .............................................................  (2.6) 

1,2D + 1,6(Lr atau R) + (L atau 0,5W) ..............................................  (2.7) 

1,2D + 1,0E + L  .................................................................................  (2.8) 

0,9D + 1,0E ........................................................................................  (2.9) 

0,9D – 1,0Ev + 1,0Eh .........................................................................  (2.10) 

1,0D + 0,7Ev + 0,7Eh .........................................................................  (2.11) 

0,6D – 0,7Ev + 0,7Eh .........................................................................  (2.12) 

 
Tabel 2.6 Kombinasi pembebanan analisis struktur 

No Kombinasi Pembebanan Keterangan 
1.  1,4 DL 

Kombinasi 
pembebanan 
akibat beban 
mati, beban 
hidup, beban 

angin dan beban 
hujan 

2.  1,2 DL + 1,6 LL + 0,5 LR 
3.  1,2 DL + 1,6 LL + 0,5 R 
4.  1,2 DL + 1,6 LR + 1 LL 
5.  1,2 DL + 1,6 LR + 0,5Wx 
6.  1,2 DL + 1,6 LR + 0,5Wy 
7.  1,2 DL + 1,6 R + 1 LL 
8.  1,2 DL + 1,6 R + 0,5Wx 
9.  1,2 DL + 1,6 R + 0,5Wy 
10.  1,2 DL + 1 W + 1 LL + 0,5 LR 
11.  1,2 DL + 1 W + 1 LL + 0,5 R 
12.  0,9DL + 1Wx 
13.  0,9DL + 1Wy 
14.  (1,2 DL + 0.2Sds) + 1SEx (ρ) + 0,3SEy (ρ) + 1LL 

Kombinasi 
pembebanan 
sementara  

15.  (1,2 DL + 0.2Sds) + 1SEx (ρ) - 0,3SEy (ρ) + 1LL 
16.  (1,2 DL + 0.2Sds) - 1SEx (ρ) + 0,3SEy (ρ) + 1LL 
17.  (1,2 DL + 0.2Sds) - 1SEx (ρ) - 0,3SEy (ρ) + 1LL 
18.  (1,2 DL + 0.2Sds) + 0,3SEx (ρ) + 1SEy (ρ) + 1LL 
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Lanjutan Tabel 2.6 

No Kombinasi Pembebanan Keterangan 
19.  (1,2 DL + 0.2Sds) + 0,3SEx (ρ) - 1SEy (ρ) + 1LL (Akibat beban 

mati, beban 
hidup, dan 
beban gempa) 

20.  (1,2 DL + 0.2Sds) - 0,3SEx (ρ) + 1SEy (ρ) + 1LL 
21.  (1,2 DL + 0.2Sds) - 0,3SEx (ρ) - 1SEy (ρ) + 1LL 
22.  (0,9 DL + 0.2Sds) + 1SEx (ρ) + 0,3SEy (ρ) 
23.  (0,9 DL + 0.2Sds) + 1SEx (ρ) - 0,3SEy (ρ) 
24.  (0,9 DL + 0.2Sds) - 1SEx (ρ) + 0,3SEy (ρ) 
25.  (0,9 DL + 0.2Sds) - 1SEx (ρ) - 0,3SEy (ρ) 
26.  (0,9 DL + 0.2Sds) + 0,3SEx (ρ) + 1SEy (ρ) 
27.  (0,9 DL + 0.2Sds) + 0,3SEx (ρ) - 1SEy (ρ) 
28.  (0,9 DL + 0.2Sds) - 0,3SEx (ρ) + 1SEy (ρ) 
29.  (0,9 DL + 0.2Sds) - 0,3SEx (ρ) - 1SEy (ρ) 

 (Sumber: SNI 1727:2020) 

 
Dengan:  

D  = Beban mati yang diakibatkan oleh berat konstruksi permanen, termasuk 

dinding, lantai, atap, plafon, partisi tetap, tangga, dan peralatan layan 

tetap 

E   = Beban gempa 

L   = Beban hidup yang ditimbulkan oleh penggunaan gedung, termasuk kejut, 

tetapi tidak termasuk beban lingkungan seperti angin, hujan 

Lr  = Beban hidup di atap yang ditimbulkan selama perawatan oleh pekerja, 

peralatan, dan material atau selama pengguanaan biasa oleh orang dan 

benda bergerak 

R   = Beban hujan, tidak termasuk yang diakibatkan genangan air  

2.2.5 Perencanaan ketahanan gempa 

Berdasarkan SNI 1726:2019 Pasal 4.1.1 bahwa, pengaruh dari beban gempa 

harus selalu ditinjau dalam perencanaan dan evaluasi pada struktur bangunan 

gedung. Gempa rencana ditetapkan sebagai gempa dengan probabilitas terlampaui 

besarannya selama umur struktur bangunan 50 tahun adalah sebesar 2%. 
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1. Faktor keutamaan gempa dan kategori risiko struktur bangunan 

Untuk berbagai kategori risiko struktur bangunan gedung dan nongedung sesuai 

dengan Tabel 2.7 kemudian harus dikalikan dengan faktor keutamaan gempa 

(Ie) menurut Tabel 2.8 berikut: 

 
Tabel 2.7 Kategori risiko bangunan gedung dan nongedung untuk beban 

gempa 

Jenis Pemanfaatan Kategori Risiko 
Gedung dan nongedung yang memiliki risiko rendah 
terhadap jiwa manusia pada saat terjadi kegagalan, 
termasuk, tapi tidak dibatasi untuk, antara lain:  

 Fasilitas pertanian, perkebunan, perternakan, dan 
perikanan  

 Fasilitas sementara  

 Gudang penyimpanan  

 Rumah jaga dan struktur kecil lainnya 

I 

Semua gedung dan struktur lain, kecuali yang 
termasuk dalam kategori risiko I, III, IV, termasuk, 
tapi tidak dibatasi untuk: 
- Perumahan 
- Rumah toko dan rumah kantor 
- Pasar 
- Gedung perkantoran 
- Gedung apartemen / rumah susun  
- Pusat perbelanjaan / mall 
- Bangunan industri 
- Fasilitas manufaktur 

II 

Gedung dan nongedung yang memiliki risiko tinggi 
terhadap jiwa manusia pada saat terjadi kegagalan, 
termasuk, tapi tidak dibatasi untuk:  
- Bioskop  
- Gedung pertemuan  
- Stadion  
- Fasilitas kesehatan yang tidak memiliki unit bedah 

dan unit gawat darurat  
- Fasilitas penitipan anak  
- Penjara  
- Bangunan untuk orang jompo  

III 



 

15 
 

Lanjutan Tabel 2.7 

Jenis Pemanfaatan Kategori Risiko 
Gedung dan nongedung, tidak termasuk kedalam 
kategori risiko IV, yang memiliki potensi untuk 
menyebabkan dampak ekonomi yang besar dan/atau 
gangguan massal terhadap kehidupan masyarakat 
sehari-hari bila terjadi kegagalan, termasuk, tapi tidak 
dibatasi untuk:  
- Pusat pembangkit listrik biasa  
- Fasilitas penanganan air  
- Fasilitas penanganan limbah  
- Pusat telekomunikasi 

III 

Gedung dan nongedung yang dikategorikan sebagai 
fasilitas yang penting, termasuk, tetapi tidak dibatasi 
untuk:  
- Bangunan-bangunan monumental  
- Gedung sekolah dan fasilitas pendidikan  
- Rumah ibadah  
- Rumah sakit dan fasilitas kesehatan lainnya yang 

memiliki fasilitas bedah dan unit gawat darurat  
- Fasilitas pemadam kebakaran, ambulans, dan 

kantor polisi, serta garasi kendaraan darurat  
- Tempat perlindungan terhadap gempa bumi, 

tsunami, angin badai, dan tempat perlindungan 
darurat lainnya  

- Fasilitas kesiapan darurat, komunikasi, pusat 
operasi dan fasilitas lainnya untuk tanggap darurat  

- Pusat pembangkit energi dan fasilitas publik 
lainnya yang dibutuhkan pada saat keadaan darurat  

- Struktur tambahan (termasuk menara 
telekomunikasi, tangki penyimpanan bahan bakar, 
menara pendingin, struktur stasiun listrik, tangki 
air pemadam kebakaran atau struktur rumah atau 
struktur pendukung air atau material atau peralatan 
pemadam kebakaran) yang disyaratkan untuk 
beroperasi pada saat keadaan darurat 

IV 

(Sumber: SNI 1726:2019)  
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BAB I 

PENDAHULUAN 

1.1 Latar Belakang 

Indonesia termasuk kedalam daerah yang rawan bencana gempa bumi 

karena dikelilingi oleh cincin api pasifik (Ring of fire) dan berada pada wilayah 

pertemuan tiga lempeng tektonik yaitu lempeng Indo-Australia, Eurasia dan 

lempeng pasifik. Hal inilah yang menyebabkan wilayah Indonesia sering 

mengalami bencana gempa bumi. Menurut data yang dikeluarkan Badan Geologi 

Kementerian Energi dan Sumber Daya Mineral (ESDM) pada tahun 2018 terjadi 

14 gempa bumi dan pada tahun 2021 juga terjadi 26 gempa bumi dengan daya rusak 

signifikan, gempa bumi pada tahun 2021 merupakan kejadian gempa bumi tertinggi 

dalam kurun 20 tahun terakhir (Supartoyo, 2022). Disamping itu, pulau Lombok 

menjadi salah satu kepulauan di Indonesia yang secara tektonik merupakan 

kawasan seismik aktif. Pulau Lombok terletak diantara dua pembangkit gempa 

yaitu, zona subduksi Indo-Australia dari arah selatan dan terdapat struktur geologi 

sesar naik flores dari arah utara. 

Pulau Lombok kerap menjadi lokasi gempa besar. Gempa yang terjadi pada 

tanggal 29 Juli 2018 di pulau Lombok ini berkekuatan 6,4 Skala Richter dan disusul 

dengan kekuatan 7,0 Skala Richter pada tanggal 5 Agustus 2018. Gempa ini 

menimbulkan kerusakan bangunan, fasilitas umum dan banyaknya korban jiwa. 

Kota Mataram yang menjadi pusat kota di pulau Lombok juga terkena dampak dari 

gempa bumi ini. Berada di wilayah risiko kegempaan 4 membuat kota Mataram 

memiliki risiko yang sangat besar terhadap kerusakan infrastruktur gedung yang 

cukup parah akibat gempa.  

Rusaknya gedung menimbulkan kerugian secara moril dan material, 

umumnya menyebabkan korban jiwa akibat tertimpa bangunan yang runtuh pada 

saat gempa. Gempa bumi tidak dapat dipungkiri untuk dicegah terjadinya, namun 

perlu adanya upaya untuk meminimalisir kerusakan akibat gempa. Berbagai upaya 

telah dilakukan untuk meminimalisir dampak gempa bumi terhadap struktur 

bangunan dengan mengembangkan bangunan tahan gempa, mulai dengan membuat 

dinding geser (Shear Wall) hingga menambahkan perkuatan dengan sistem pengaku 
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(Bracing). Namun seiring perkembangan zaman, dikembangkanlah inovasi untuk 

melakukan proteksi bangunan gedung terhadap gempa yang lebih efisien yaitu Base 

Isolator. Negara dengan risiko tinggi terhadap gempa seperti Jepang, Turki, Italy, 

Portugal, USA, Iran, China, Selandia Baru, dan Taiwan telah banyak menggunakan 

base isolator ini. 

Base isolator ini memiliki konsep yaitu memisahkan struktur atas dengan 

struktur bawah yang bekerja dengan menjaga struktur diatasnya sebagai satu 

kesatuan, arah getaran gempa yang terjadi secara acak hanya akan mempengaruhi 

base isolator karena base isolator ini sifatnya elastis, sedangkan struktur diatasnya 

akan bergetar atau bergerak sebagai satu kesatuan struktur (Lesmana, 2013). 

Keunggulan dari penggunaan base isolator dibandingkan dengan struktur bangunan 

tahan gempa yang lain adalah mampu mereduksi gaya gempa yang terjadi dari 

struktur bawah ke struktur atas bangunan dan base isolator ini juga mampu 

memperkecil nilai displacement dan drift pada setiap lantai struktur bangunan. Ada 

banyak sistem isolasi yang digunakan pada base isolator, namun pada penelitian 

ini akan digunakan base isolator dengan tipe High Dumping Rubber Bearing 

(HDRB).  

Penerapan base isolator sendiri belum ada ditemukan pada struktur 

bangunan di pulau Lombok khususnya di kota Mataram, sehingga perlu dipelajari 

dan diteliti untuk mengaplikasikan sistem tersebut dalam menjamin kemampuan 

struktur bangunan di kota Mataram untuk meminimalisir efek dari gempa bumi 

yang terjadi. Salah satu bangunan di kota Mataram menjadi tempat dilakukannya 

penelitian yaitu gedung Sapadia Hotel yang stuktur bangunannya masih 

menggunakan beton bertulang dengan Sistem Rangka Pemikul Momen Khusus 

tanpa adanya peredam gempa, sehingga diperlukan adanya proteksi terhadap 

gempa. Mengacu dari permasalahan tersebut, penulis memiliki inovasi dengan 

melakukan penelitian yang bertujuan untuk menganalisis Penggunaan base isolator 

dengan Tipe High Dumping Rubber Bearing (HDRB) pada bangunan Sapadia 

Hotel, yang tentunya dengan menerapkan peraturan Standar Nasional Indonesia 

yang berlaku dengan benar. 
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1.2 Rumusan Masalah 

Berdasarkan latar belakang diatas, ada beberapa permasalahan yang dapat 

ditarik untuk penyusunan tugas akhir ini:  

1. Bagaimana pengaruh penggunaan base isolator dengan tipe High Dumping 

Rubber Bearing (HDRB) terhadap perilaku struktur beton bertulang pada 

bangunan tinggi akibat beban gempa? 

2. Bagaimana base shear, displacement, dan drift pada struktur bangunan yang 

menggunakan fixed base dengan sistem struktur base isolator pada gedung 

Sapadia Hotel? 

3. Bagaimana perbandingan momen dan gaya geser pada struktur gedung yang 

menggunakan struktur fixed base dengan struktur base isolator pada gedung 

Sapadia Hotel? 

4. Bagaimana level kinerja struktur gedung fixed base dengan struktur base 

isolator gedung Sapadia Hotel berdasarkan ATC-40 menggunakan analisa 

pushover? 

 

1.3 Tujuan Penelitian 

Berdasarkan rumusan masalah diatas, tujuan utama dari penelitian ini adalah 

sebagai berikut: 

1. Mengetahui perilaku struktur akibat penggunaan base isolator pada beton 

bertulang bangunan tinggi akibat beban gempa. 

2. Mengetahui perbandingan base shear, displacement, dan drift pada struktur 

bangunan yang menggunakan fixed base dengan sistem struktur base isolator 

pada gedung Sapadia Hotel. 

3. Mengetahui perbandingan momen dan gaya geser pada struktur primer gedung 

yang menggunakan struktur fixed base dengan struktur base isolator pada 

gedung Sapadia Hotel. 

4. Mengetahui level kinerja struktur gedung fixed base dengan struktur base 

isolator gedung Sapadia Hotel berdasarkan ATC-40 menggunakan analisa 

pushover. 
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1.4 Batasan Masalah 

Adapun batasan masalah yang digunakan dalam penelitian agar lebih 

terkendali dan relevan dengan apa yang ingin dibuktikan adalah: 

1. Bangunan gedung yang ditinjau berfungsi sebagai Hotel. 

2. Lokasi penelitian terletak di Gedung Sapadia Hotel. 

3. Bangunan terdiri dari 7 lantai dengan ketinggian 29 m. 

4. Peraturan beton menggunakan SNI 2847-2019. 

5. Pembebanan gempa menggunakan SNI 1726-2019. 

6. Tipe base isolator adalah High Dumping Rubber Bearing. 

7. Program yang digunakan untuk analisis struktur adalah ETABS v.18. 

8. Level kinerja menggunakan metode pushover berdasarkan ATC-40. 

9. Tidak membahas biaya dan metode pelaksanaan konstruksi. 

10. Tidak membahas perhitungan sambungan base isolator dengan kolom. 

11. Tidak membahas penulangan struktur. 
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BAB II 

TINJAUAN PUSTAKA DAN LANDASAN TEORI 

2.1 Tinjauan Pustaka 

Pada penelitian ini mengacu pada penelitian-penelitian sebelumnya dan 

peraturan-peraturan yang berlaku. Syahnandito et.al (2020). Penelitian yang 

dilakukan dengan judul Pengaruh Penggunaan Base Isolation High Damping 

Rubber Bearing pada Struktur Beton Bertulang. Adapun permasalahan yang 

didapatkan adalah belum ditemukannya struktur bangunan bertingkat yang 

mengaplikasikan isolasi karet yang dapat menjamin struktur bangunan dari gempa 

di daerahnya. Parameter yang digunakan diantaranya Beban mati, beban mati 

tambahan, beban sendiri struktur, beban hidup dan beban gempa dengan 

penggunaan metode Base Isolation System. Hasil analisa dari penelitian ini 

didapatkan periode struktur fix base sebesar 4,212 detik, gaya geser dasar 

didapatkan sebesar 1470,725 ton. Sedangkan pada struktur dengan base isolation 

berdasarkan hasil analisa didapatkan periode sebesar 5,500 detik, dengan gaya 

geser dasar didapatkan sebesar 1286,071 ton. Maka dapat disimpulkan bahwa pada 

struktur dengan base isolation terjadi peningkatan periode sebesar 30,58%, 

sedangkan gaya geser dasar terjadi penurunan 12,56%. 

Samsya (2017). Melakukan penelitian dengan judul Evaluasi Aplikasi 

Penggunaan Base Isolation Pada Gedung Grand Keisha Menggunakan Analisa 

Pushover. Pada penelitian tersebut membahas perbandingan struktur fixbase 

dengan struktur base isolation dengan tipe High Damping Rubber Bearing. 

penelitian ini bertujuan untuk mengetahui sejauh mana base isolation dapat bekerja 

terhadap perilaku bangunan. Studi kasus yang digunakan adalah Hotel Grand 

Keisha terletak di Padang yang zona gempanya merupakan gempa tinggi. 

Dilakukan analisa pushover untuk mengetahui kinerja struktur jika terkena gempa. 

Dari analisa yang dilakukan, base isolation didapatkan peningkatan nilai gaya geser 

sistem struktur isolasi terhadap system struktur fixbase sebesar 20,12%. 

Displacement pada struktur base isolation dan fixbase mengalami penurunan, 

sesuai dengan gempa dinamik yang ditinjau sebesar 89,86% (arah x) dan 88,79% 

(arah y). Nilai simpangan horizontal (Drift) pada struktur base isolation dan 
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struktur fixbase mengalami reduksi sebesar 63,63% (arah x) dan 68,18% (arah y). 

Didapatkan level kinerja struktur kategori B (Operasional) pada struktur base 

isolation, yang artinya tidak ada kerusakan berarti pada struktur dan non-struktur, 

dengan kata lain bangunan tetap berfungsi. Pada struktur fixbase didapatkan level 

kinerja struktur dengan kategori IO (Immediate Occupancy), yang berarti 

komponen non struktur masih berada ditempatnya dan jika utilitasnya masih 

tersedia maka komponen tersebut masih berfungsi. 

 

2.2 Landasan Teori 

2.2.1 Modulus elastisitas 

Modulus elastisitas digunakan untuk mengetahui seberapa besar rasio objek 

tersebut dapat berubah (deformasi elastis) ketika mengalami tekanan atau regangan. 

Material beton dan baja dapat mengalami deformasi elastis sehingga perlu diketahui 

Modulus elastisitasnya. Modulus elastisitas baja ditentukan berdasarkan SNI 

1729:2020 Pasal B4 Tabel B4.1b sebesar 200.000 MPa dan modulus elastisitas 

beton dihitung dengan persamaan 2.1. 

𝐸 = 4700 𝑥 √𝐹′𝑐   ...............................................................................  (2.1) 

Dengan:  

F’c = Kuat tekan beton 

E = Modulus elastisitas 

2.2.2 Preliminary desain 

a. Preliminary pelat 

Pelat adalah suatu elemen struktural yang membentuk permukaan datar secara 

horizontal yang dapat menerima beban mati maupun beban hidup kemudian 

menyalurkannya menuju balok, pelat ini biasanya diaplikasikan pada lantai dan 

atap dak. Pelat beton bidang horizontal yang terbuat dari campuran pasir, 

semen, air, kerikil dan admixture. Pelat ini memiliki ketebalan jauh lebih kecil 

dari balok, hal ini karna pelat hanya menahan beban mati dan hidup. Ketebalan 

dari pelat biasanya 12 cm sampai 15 cm tergantung beban yang dipikul. Karna 

berada pada lantai maka, elemen ini perlu didukung oleh rangka balok dan 
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kolom di bawahnya. Struktur balok dan pelat biasanya dicor secara bersamaan 

dengan tujuan untuk menghasilkan suatu kesatuan struktur yang monolit, 

sehingga bisa diasumsikan sebagai difragma. Pada skripsi ini digunakan pelat 

dua arah, yaitu pelat dengan tulangan pokok dua arah yang digunakan apabila 

panjang/lebar bentang pelat kurang dari 2 (L/W < 2). Ketebalan minimum dari 

pelat dua arah nonprategang dengan balok diantara tumpuan semua sisinya 

dapat dihitung berdasarkan Tabel 2.1 Ketebalan minimum pelat dua arah 

nonprategang. 

 

Tabel 2.1 Ketebalan minimum pelat dua arah nonprategang 

fy, 

MPa 

Tanpa drop panel 

Panel eksterior 
Panel interior 

Tanpa balok tepi Dengan balok tepi 

280 Ln/33 Ln/36 Ln/36 

420 Ln/30 Ln/33 Ln/33 

520 Ln/28 Ln/31 Ln/31 

(Sumber: SNI 2847:2019) 

 

b. Preliminary balok 

Balok adalah komponen portal dengan bentang horizontal. Adapun beban yang 

bekerja pada balok biasanya berupa beban geser, beban lentur, dan momen 

punter (torsi), sehingga untuk menahan beban tersebut dibutuhkan baja 

tulangan. Tulangan ini berupa tulangan longitudinal atau tulangan memanjang 

yang akan menahan beban lentur, serta tulangan geser atau begel yang akan 

menahan beban torsi dan geser (Asroni, 2010). Untuk preliminary balok 

biasanya ditentukan oleh arsitek. Namun untuk menentukan desain yang aman 

biasanya mengacu pada Tabel 2.2 Tinggi minimum balok nonprategang. 

 

Tabel 2.2 Tinggi minimum balok nonprategang 

Kondisi perletakan Tinggi minimum (hmin) 

Perletakan sederhana L/16 

Menerus satu sisi L/18,5 

Menerus dua sisi L/21 

Kantilever L/8 

(Sumber: SNI 2847:2019) 



 

8 

 

Catatan: Rumusan tabel diatas dapat digunakan pada beton mutu normal dan 

tulangan mutu 420 MPa. Untuk mutu baja tulangan diatas 420 MPa, tinggi 

minimum pada tabel diatas harus dikalikan dengan Persamaan 2.2. 

(0,4 + fy / 700) ............................................................................... (2.2) 

Dengan: 

Fy = Kuat leleh baja tulangan 

c. Preliminary kolom 

Kolom berfungsi sebagai pendukung untuk menerima beban dari balok dan 

pelat yang kemudian akan diteruskan menuju tanah dasar melalui pondasi. 

Beban yang ditimbulkan oleh balok dan pelat ini berupa beban tekan aksial dan 

momen lentur (akibat kontinuitas konstruksi). Oleh karena itu, kolom dapat 

didefinisikan sebagai suatu struktur yang memikul beban aksial dengan/tanpa 

momen lentur (Asroni, 2010). 

Desain awal kolom bisa dihitung dengan Persamaan 2.3 dan Persamaan 2.4: 

b kolom = b balok terbesar + 100 ................................................. (2.3) 

h kolom = b kolom x
(

P total bangunan

jumlah pias
) x n melintang

(
L total bangunan

jumlah pias
) x n memanjang

  ....................... (2.4) 

Dengan:  

b  = Lebar elemen struktur 

h  = Tinggi elemen struktur 

P  = Panjang bangunan 

L = Lebar bangunan 

n  = Jumlah pias 

2.2.3 Pembebanan 

Berdasarkan SNI 1727:2020 tentang beban minimum untuk perancangan 

bangunan bangunan Gedung dan struktur lain. Beban yang bekerja pada Gedung 

terdiri dari beban hidup, beban mati (berat struktur sendiri), dan beban mati 

tambahan (berat elemen non struktural). 

1. Beban mati (Dead load) 

Beban mati adalah berat seluruh bahan konstruksi bangunan gedung yang 

terpasang, baik itu komponen struktural maupun komponen arsitektural beserta 
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peralatan layan terpasang lain termasuk berat derek dan sistem pengangkut 

material. Untuk berat masing-masing material penyusun elemen struktural 

dilihat pada Tabel 2.3 Rekapitulasi beban Mati (Dead Load). 

 

Tabel 2.3 Rekapitulasi beban Mati (Dead Load) 

Material 
Berat Volume 

kN/m3 kg/m3 

Beton (tidak bertulang) 22 2200 

Beton bertulang 24 -25 2400 - 2500 

Baja 78,5 7850 

Mata merah 17 1700 

Adukan semen 20 - 21 2000 - 2100 

Air 10 1000 

Tanah (umum) 17 - 18 1700 - 1800 

Pasir kering 16 1600 

Pasir jenuh 18 1800 

Kayu (klas I) 10 1000 

Aspal 14 1400 

(Sumber: SNI 1727:2020) 

 

2. Beban mati tambahan (Super imposed dead load) 

Beban mati tambahan atau super imposed dead load adalah berat komponen 

non struktural yang terdapat pada struktur bangunan. Untuk berat mati 

tambahan bisa di lihat pada Tabel 2.4 Rekapitulasi beban mati tambahan.  
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Tabel 2.4 Rekapitulasi beban mati tambahan 

Material 
Berat Volume 

kN/m3 kg/m3 

Atap:     

Genteng keramik (reng + kasau) 0,5 50 

Plafon, ceilling, langit-langit 0,18 18 

Atap metal 1mm (reng + kasau) 0,1 10 

Dek Beton (screed)     

Keramik (+ screed/adukan semen) 1,5 150 

Raised floor (+ carpet) 0,2 20 

Dinding:     

Batako tanpa lubang, t 15 cm 3 300 

Hebel 10 cm + render 1 100 

Hebel 12.5 cm + render 1,2 120 

Celcon 10 cm + render 1,5 150 

Celcon 12.5 cm + render 1,7 170 

(Sumber: SNI 1727:2020) 

 

Dalam penelitian ini, model juga memiliki akses lift dimana lift adalah 

transportasi vertikal pada gedung yang berfungsi untuk mengangkut orang atau 

barang. Lift umumnya digunakan pada gedung-gedung bertingkat banyak yang 

biasanya lebih dari tiga atau empat lantai. Bangunan yang lebih rendah 

biasanya hanya menggunakan tangga atau eskalator. Lift-lift di zaman modern 

mempunyai tombol penunjuk lantai yang dapat dipilih penggunanya sesuai 

lantai tujuan. Dalam sistem penggerak lift ada tiga jenis mesin, yaitu Hidraulic, 

Traction, dan Hoist. Dalam penelitian ini digunakan lift dengan sistem tanpa 

ruang mesin seperti Gambar 2.1. 
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Gambar 2.1 Lift tanpa ruang mesin 

(Sumber: Aoyama, 2023) 

 

3. Beban hidup (Live load) 

Beban hidup atau live load adalah beban yang berasal dari penghunian atau 

penggunaan gedung seperti dari barang atau orang yang dapat berpindah tempat 

sehingga mengakibatkan perubahan dalam pembebanan lantai dan atap. Beban 

hidup terdistribusi merata minimal, Lo dan beban hidup terpusat minimal bisa 

di lihat pada tabel 2.5 Rekapitulasi beban hidup. 

 

Tabel 2.5 Rekapitulasi beban hidup 

Jenis beban hidup Berat (kN/m2) 

Beban hidup ruang kantor 2,40 

Beban hidup ruang computer 4,79 

Beban hidup ruang operasi, Laboratorium 2,87 

Helipad, Helikopter dengan berat lepas landas lebih 

dari 3000 Lb (13,35 kN) 
2,87 

Beban hidup koridor  diatas lantai pertama 3,83 

Ruang penyimpanan 7,18 

Beban hidup tangga 4,79 

Beban hidup dak 0,96 

Beban hidup ruang pertemuan 4,79 

Beban hidup lantai parkir 1,92 

(Sumber: SNI 1727:2020) 
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2.2.4 Kombinasi pembebanan 

Berdasarkan SNI 1727:2020 bahwa struktur, komponen-elemen struktur 

atas maupun bawah harus di desain hingga kuat rencana atau bahkan melebihi dari 

pembebanan terfaktor dengan kombinasi-kombinasi yang sesuai dengan Persamaan 

2.5 sampai dengan Persamaan 2.12 dan untuk penjabarannya dapat dilihat pada 

Tabel 2.6 Kombinasi pembebanan analisis struktur: 

1,4D  ...................................................................................................  (2.5) 

1,2D + 1,6L + 0,5(Lr atau R) .............................................................  (2.6) 

1,2D + 1,6(Lr atau R) + (L atau 0,5W) ..............................................  (2.7) 

1,2D + 1,0E + L  .................................................................................  (2.8) 

0,9D + 1,0E ........................................................................................  (2.9) 

0,9D – 1,0Ev + 1,0Eh .........................................................................  (2.10) 

1,0D + 0,7Ev + 0,7Eh .........................................................................  (2.11) 

0,6D – 0,7Ev + 0,7Eh .........................................................................  (2.12) 

 

Tabel 2.6 Kombinasi pembebanan analisis struktur 

No Kombinasi Pembebanan Keterangan 

1.  1,4 DL 

Kombinasi 

pembebanan 

akibat beban 

mati, beban 

hidup, beban 

angin dan beban 

hujan 

2.  1,2 DL + 1,6 LL + 0,5 LR 

3.  1,2 DL + 1,6 LL + 0,5 R 

4.  1,2 DL + 1,6 LR + 1 LL 

5.  1,2 DL + 1,6 LR + 0,5Wx 

6.  1,2 DL + 1,6 LR + 0,5Wy 

7.  1,2 DL + 1,6 R + 1 LL 

8.  1,2 DL + 1,6 R + 0,5Wx 

9.  1,2 DL + 1,6 R + 0,5Wy 

10.  1,2 DL + 1 W + 1 LL + 0,5 LR 

11.  1,2 DL + 1 W + 1 LL + 0,5 R 

12.  0,9DL + 1Wx 

13.  0,9DL + 1Wy 

14.  (1,2 DL + 0.2Sds) + 1SEx (ρ) + 0,3SEy (ρ) + 1LL 

Kombinasi 

pembebanan 

sementara  

15.  (1,2 DL + 0.2Sds) + 1SEx (ρ) - 0,3SEy (ρ) + 1LL 

16.  (1,2 DL + 0.2Sds) - 1SEx (ρ) + 0,3SEy (ρ) + 1LL 

17.  (1,2 DL + 0.2Sds) - 1SEx (ρ) - 0,3SEy (ρ) + 1LL 

18.  (1,2 DL + 0.2Sds) + 0,3SEx (ρ) + 1SEy (ρ) + 1LL 
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Lanjutan Tabel 2.6 

No Kombinasi Pembebanan Keterangan 

19.  (1,2 DL + 0.2Sds) + 0,3SEx (ρ) - 1SEy (ρ) + 1LL (Akibat beban 

mati, beban 

hidup, dan 

beban gempa) 

20.  (1,2 DL + 0.2Sds) - 0,3SEx (ρ) + 1SEy (ρ) + 1LL 

21.  (1,2 DL + 0.2Sds) - 0,3SEx (ρ) - 1SEy (ρ) + 1LL 

22.  (0,9 DL + 0.2Sds) + 1SEx (ρ) + 0,3SEy (ρ) 

23.  (0,9 DL + 0.2Sds) + 1SEx (ρ) - 0,3SEy (ρ) 

24.  (0,9 DL + 0.2Sds) - 1SEx (ρ) + 0,3SEy (ρ) 

25.  (0,9 DL + 0.2Sds) - 1SEx (ρ) - 0,3SEy (ρ) 

26.  (0,9 DL + 0.2Sds) + 0,3SEx (ρ) + 1SEy (ρ) 

27.  (0,9 DL + 0.2Sds) + 0,3SEx (ρ) - 1SEy (ρ) 

28.  (0,9 DL + 0.2Sds) - 0,3SEx (ρ) + 1SEy (ρ) 

29.  (0,9 DL + 0.2Sds) - 0,3SEx (ρ) - 1SEy (ρ) 

 (Sumber: SNI 1727:2020) 

 

Dengan:  

D  = Beban mati yang diakibatkan oleh berat konstruksi permanen, termasuk 

dinding, lantai, atap, plafon, partisi tetap, tangga, dan peralatan layan 

tetap 

E   = Beban gempa 

L   = Beban hidup yang ditimbulkan oleh penggunaan gedung, termasuk kejut, 

tetapi tidak termasuk beban lingkungan seperti angin, hujan 

Lr  = Beban hidup di atap yang ditimbulkan selama perawatan oleh pekerja, 

peralatan, dan material atau selama pengguanaan biasa oleh orang dan 

benda bergerak 

R   = Beban hujan, tidak termasuk yang diakibatkan genangan air  

2.2.5 Perencanaan ketahanan gempa 

Berdasarkan SNI 1726:2019 Pasal 4.1.1 bahwa, pengaruh dari beban gempa 

harus selalu ditinjau dalam perencanaan dan evaluasi pada struktur bangunan 

gedung. Gempa rencana ditetapkan sebagai gempa dengan probabilitas terlampaui 

besarannya selama umur struktur bangunan 50 tahun adalah sebesar 2%.  
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1. Faktor keutamaan gempa dan kategori risiko struktur bangunan 

Untuk berbagai kategori risiko struktur bangunan gedung dan nongedung sesuai 

dengan Tabel 2.7 kemudian harus dikalikan dengan faktor keutamaan gempa 

(Ie) menurut Tabel 2.8 berikut: 

 

Tabel 2.7 Kategori risiko bangunan gedung dan nongedung untuk beban 

gempa 

Jenis Pemanfaatan Kategori Risiko 

Gedung dan nongedung yang memiliki risiko rendah 

terhadap jiwa manusia pada saat terjadi kegagalan, 

termasuk, tapi tidak dibatasi untuk, antara lain:  

− Fasilitas pertanian, perkebunan, perternakan, dan 

perikanan  

− Fasilitas sementara  

− Gudang penyimpanan  

− Rumah jaga dan struktur kecil lainnya 

I 

Semua gedung dan struktur lain, kecuali yang 

termasuk dalam kategori risiko I, III, IV, termasuk, 

tapi tidak dibatasi untuk: 

- Perumahan 

- Rumah toko dan rumah kantor 

- Pasar 

- Gedung perkantoran 

- Gedung apartemen / rumah susun  

- Pusat perbelanjaan / mall 

- Bangunan industri 

- Fasilitas manufaktur 

II 

Gedung dan nongedung yang memiliki risiko tinggi 

terhadap jiwa manusia pada saat terjadi kegagalan, 

termasuk, tapi tidak dibatasi untuk:  

- Bioskop  

- Gedung pertemuan  

- Stadion  

- Fasilitas kesehatan yang tidak memiliki unit bedah 

dan unit gawat darurat  

- Fasilitas penitipan anak  

- Penjara  

- Bangunan untuk orang jompo  

III 
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Lanjutan Tabel 2.7 

Jenis Pemanfaatan Kategori Risiko 

Gedung dan nongedung, tidak termasuk kedalam 

kategori risiko IV, yang memiliki potensi untuk 

menyebabkan dampak ekonomi yang besar dan/atau 

gangguan massal terhadap kehidupan masyarakat 

sehari-hari bila terjadi kegagalan, termasuk, tapi tidak 

dibatasi untuk:  

- Pusat pembangkit listrik biasa  

- Fasilitas penanganan air  

- Fasilitas penanganan limbah  

- Pusat telekomunikasi 

III 

Gedung dan nongedung yang dikategorikan sebagai 

fasilitas yang penting, termasuk, tetapi tidak dibatasi 

untuk:  

- Bangunan-bangunan monumental  

- Gedung sekolah dan fasilitas pendidikan  

- Rumah ibadah  

- Rumah sakit dan fasilitas kesehatan lainnya yang 

memiliki fasilitas bedah dan unit gawat darurat  

- Fasilitas pemadam kebakaran, ambulans, dan 

kantor polisi, serta garasi kendaraan darurat  

- Tempat perlindungan terhadap gempa bumi, 

tsunami, angin badai, dan tempat perlindungan 

darurat lainnya  

- Fasilitas kesiapan darurat, komunikasi, pusat 

operasi dan fasilitas lainnya untuk tanggap darurat  

- Pusat pembangkit energi dan fasilitas publik 

lainnya yang dibutuhkan pada saat keadaan darurat  

- Struktur tambahan (termasuk menara 

telekomunikasi, tangki penyimpanan bahan bakar, 

menara pendingin, struktur stasiun listrik, tangki 

air pemadam kebakaran atau struktur rumah atau 

struktur pendukung air atau material atau peralatan 

pemadam kebakaran) yang disyaratkan untuk 

beroperasi pada saat keadaan darurat 

IV 

(Sumber: SNI 1726:2019)  
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Tabel 2.8 Faktor keutamaan gempa 

Kategori risiko Faktor keutamaan gempa, Ie 

I atau II 1,0 

III 1,25 

IV 1,50 

(Sumber: SNI 1726:2019) 

 

2. Klasifikasi situs 

Berdasarkan SNI 1726:2019 Pasal 5.1 bahwa, dalam perumusan kriteria desain 

seismik suatu bangunan di permukaan tanah atau penentuan amplifikasi besaran 

percepatan gempa puncak dari batuan dasar ke permukaan tanah untuk suatu 

situs, maka situs tersebut harus dilakukan klasifikasi terlebih dahulu. Profil 

tanah di situs harus dilakukan klasifikasi sesuai dengan Tabel 2.9 Klasifikasi 

situs berdasarkan profil tanah lapisan 30 m paling atas. 

 

Tabel 2.9 Klasifikasi situs 

Kelas Situs vs (m/s) N atau Nch Su (kPa) 

SA (batuan keras) >1500 N/A N/A 

SB (batuan) 750 - 1500 N/A N/A 

SC (tanah keras, angat 

padat dan batuan lunak) 
350 - 750 >50 ≥100 

SD (tanah sedang) 175 - 350 15 - 50 50 - 100 

SE (tanah lunak) <175 <15 <50 

 

Atau setiap profil tanah mengandung lebih dari 

3 m tanah dengan karateristik sebagai berikut :  

1. Indeks plastisitas, PI > 20 

2.Kadar air, w  ≥ 40%  

3. Kuat geser niralir su < 25 kPa 

SF (tanah khusus, yang 

membutuhkan investigasi 

geoteknik spesifik dan 

analisis respons spesifik-

situs yang mengikuti 0) 

Setiap profil lapisan tanah yang memiliki salah 

satu atau lebih dari karakteristik berikut: 

− Lempung sangat organik dan/atau gambut 

(ketebalan H > 3 m)  

− Lempung berplastisitas sangat tinggi 

(ketebalan H > 7,5 m dengan indeks 

plasitisitas PI > 75 ). 

(Sumber: SNI 1726:2019) 
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3. Menentukan koefisien situs dan parameter respon spectral percepatan gempa 

maksimum 

Berdasarkan SNI 1726:2019 Pasal 6.2 bahwa, untuk menentukan respons 

spektral percepatan gempa MCER di permukaan tanah, diperlukan suatu faktor 

amplifikasi seismik pada periode 0,2 detik dan periode 1 detik. Percepatan pada 

getaran periode pendek (Fa) dan faktor amplifikasi terkait percepatan yang 

mewakili getaran periode 1 detik (Fv) merupakan faktor yang berkaitan dengan 

amplifikasi. Faktor amplifikasi Fa dan Fv bisa di lihat pada Tabel 2.10 

Koefisien situs, Fa dan Tabel 2.11 Koefisien situs, Fv. Parameter respons 

spektral percepatan pada periode pendek (SMS) dan periode 1 detik (SM1) yang 

disesuaikan dengan pengaruh klasifikasi situs, harus ditentukan dengan 

Persamaan 2.13 dan Persamaan 2.14. 

𝑆𝑀𝑆  =  𝐹𝑎 𝑥 𝑆𝑠  .........................................................................  (2.13) 

𝑆𝑀1  = 𝐹𝑣 𝑥 𝑆1   .........................................................................  (2.14) 

Dengan:  

Ss = Parameter respons spektral percepatan gempa MCER terpetakan  untuk  

 periode pendek dilihat pada Gambar 2.2 

S1 = Parameter respons spektral percepatan gempa MCER terpetakan untuk  

 periode 1,0 detik. dilihat pada Gambar 2.3 

 

Tabel 2.10 Koefisien situs, Fa 

Kelas 

situs 

Parameter respons spektral percepatan gempa maksimum yang 

dipertimbangkan risiko-tertarget (MCER) terpetakan pada periode 

pendek, T = 0,2 detik, Ss 

 Ss ≤ 0,25 Ss = 0,5 Ss = 0,75 Ss = 1,0 Ss = 1,25 Ss ≥ 1,5 

SA 0,8 0,8 0,8 0,8 0,8 0,8 

SB 0,9 0,9 0,9 0,9 0,9 0,9 

SC 1,3 1,3 1,2 1,2 1,2 1,2 

SD 1,6 1,4 1,2 1,1 1 1 

SE 2,4 1,7 1,3 1,1 0,9 0,8 

SF SS (a) 

(Sumber: SNI 1726:2019) 
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(a) SS = Situs yang memerlukan investigasi geoteknik spesifik dan analisis 

          respon situs-spesifik. 

 

Tabel 2.11 Koefisien situs, Fv 

Kelas 

situs 

Parameter respons spektral percepatan gempa maksimum yang 

dipertimbangkan risiko-tertarget (MCER) terpetakan pada periode 

1 detik, S1 

 S1 ≤ 0,1 S1 = 0,2 S1 = 0,3 S1 = 0,4 S1 = 0,5 S1 ≥ 0,6 

SA 0,8 0,8 0,8 0,8 0,8 0,8 

SB 0,8 0,8 0,8 0,8 0,8 0,8 

SC 1,5 1,5 1,5 1,5 1,5 1,4 

SD 2,4 2,2 2 1,9 1,8 1,7 

SE 4,2 3,3 2,8 2,4 2,2 2 

SF SS (a) 

(Sumber: SNI 1726:2019) 

 

(a) SS = Situs yang memerlukan investigasi geoteknik spesifik dan analisis  

          respon situs-spesifik. 

Nilai SS dan S1 untuk parameter pergerakan tanah bisa dilihat pada Gambar 2.2 

dan Gambar 2.3: 

 

 

   Gambar 2.2 Parameter gerak tanah, Ss 

   (Sumber: SNI 1726:2019) 
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   Gambar 2.3 Parameter gerak tanah, S1 

   (Sumber: SNI 1726:2019) 

 

4. Parameter percepatan spektral desain 

Berdasarkan SNI 1726:2019 Pasal 6.3 Untuk menentukan parameter percepatan 

spectral desain untuk periode pendek, SDS dan pada periode 1 detik, SD1, harus 

ditentukan melalui Persamaan 2.15 dan Persamaan 2.16: 

𝑆𝐷𝑆 =
2

3
 𝑆𝑀𝑆  ..................................................................................  (2.15) 

𝑆𝐷1 =
2

3
𝑆𝑀1  ...................................................................................  (2.16) 

Dengan; 

SDS = Parameter percepatan spektral desain untuk periode pendek 

SD1 = Parameter respons spektral desain untuk periode 1,0 detik 

5. Spektrum respons desain 

Berikut adalah ketentuan dalam spektrum respons desain berdasarkan SNI 

1726:2019 Pasal 6.4: 

1. Untuk periode yang lebih kecil dari T0, spektrum respons percepatan desain, 

Sa, harus diambil dari Persamaan 2.17. 

𝑆𝑎 = 𝑆𝐷𝑆 (0,4 + 0,6
𝑇

𝑇0
)  .........................................................  (2.17) 

2. Untuk periode lebih besar dari atau sama dengan T0 dan lebih kecil dari atau 

sama dengan Ts, spektrum respons percepatan desain Sa, sama dengan SDS. 
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3. Untuk periode lebih besar dari Ts tetapi lebih kecil dari atau sama dengan 

TL, respons spektral percepatan desain Sa, diambil berdasarkan Persamaan 

2.18. 

𝑆𝑎 =
𝑆𝐷1

𝑇
  .................................................................................  (2.18) 

4. Untuk periode lebih besar dari TL, respons spektral percepatan desain Sa, 

diambil berdasarkan Persamaan 2.19. 

𝑆𝑎 =
𝑆𝐷1𝑇𝐿

𝑇2   ..............................................................................  (2.19) 

Maka nilai dari T0 dapat kita hitung menggunakan Persamaan 2.20 dan nilai 

Ts menggunakan Persamaan 2.21. 

𝑇0 = 0,2
𝑆𝐷1

𝑆𝐷𝑆
  ...........................................................................  (2.20) 

𝑇𝑆 =
𝑆𝐷1

𝑆𝐷𝑆
  .................................................................................  (2.21) 

Dengan: 

SDS  = Parameter percepatan spektral desain untuk periode pendek 

SD1  = Parameter respons spektral desain untuk periode 1,0 detik 

T  = Periode getar fundamental struktur. 

TL  = Transisi periode panjang 

Untuk mendapatkan nilai TL, bisa dilihat pada Gambar 2.4 

 

 

Gambar 2.4 Peta transisi periode Panjang, TL 

(Sumber: SNI 1726:2019) 
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6. Kategori desain seismik 

Struktur dengan kategori risiko I, II, atau III yang parameter respons spektral 

percepatan terpetakan pada periode 1 detik S1, lebih besar dari atau sama dengan 

0,75 harus ditetapkan sebagai struktur dengan kategori desain seismik E. 

Struktur yang diklasifikasikan sebagai risiko IV yang parameter respons 

spektral percepatan terpetakan pada periode 1 detik S1, lebih besar dari atau 

sama dengan 0,75, harus ditetapkan sebagai struktur dengan kategori desain 

seismik F. Semua struktur lainnya harus ditetapkan kategori desain seismiknya 

berdasarkan kategori risiko dan parameter respons spektral percepatan 

desainnya, SDS dan SD1. Tiap bangunan dan struktur harus ditetapkan ke dalam 

kategori desain seismik yang lebih parah, dengan mengacu pada Tabel 2.12 dan 

Tabel 2.13, terlepas dari nilai periode fundamental getaran struktur, T. Apabila 

S1 lebih kecil dari 0,75, kategori desain seismik diizinkan untuk ditentukan 

sesuai Tabel 2.12 saja, di mana berlaku semua ketentuan di bawah: 

1. Pada masing-masing dua arah ortogonal, perkiraan periode getar alami, Ta, 

kurang dari 0,8Ts. 

2. Pada masing-masing dua arah ortogonal, periode getar alami struktur yang 

digunakan untuk menghitung simpangan antar tingkat adalah kurang dari 

Ts. 

3. Persamaan (2.15) digunakan untuk menentukan koefisien respons seismik, 

Cs. 

4. Diafragma struktural adalah kaku/ rigid untuk diafragma yang fleksibel, 

jarak antara elemen vertikal pemikul gaya seismik tidak melebihi 12 m. 

 

Tabel 2.12 Kategori desain seismik percepatan periode pendek 

Nilai SDS Kategori risiko I/II/III Kategori risiko IV 

SDS < 0,167 A A 

0,167  SDS < 0,33 B C 

0,33SDS <0,5 C D 

0,50 SDS D D 

(Sumber: SNI 1726:2019) 
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Tabel 2.13 Kategori desain seismik percepatan periode 1 detik 

Nilai SD1 Kategori risiko I/II/III Kategori risiko IV 

SD1 < 0,067 A A 

0,067  SDS < 0,133 B C 

0,133   SD1< 0,20 C D 

0,20  SD1 D D 

(Sumber: SNI 1726:2019) 

 

7. Menentukan sistem struktur  

Sistem dasar pemikul gaya seismik lateral dan vertikal harus memenuhi salah 

satu tipe yang ditunjukkan pada Tabel 2.14 Setiap sistem pemikul gaya seismic 

yang dipilih harus didesain sesuai dengan tabel 2.14 untuk nilai R (koefisien 

modifikasi respons), Ω0 (faktor kuat lebih sistem) dan Cd (faktor pembesaran 

defleksi). 

 

Tabel 2.14 Faktor R, Cd dan Ω0 untuk sistem pemikul gaya seismik 

Sistem 

pemikul 

gaya 

seismik 

Koefisien 

modifikasi 

respons, R 

Faktor 

kuat 

lebih 

sistem, 

Ω0 

Faktor 

pembesaran 

defleksi Cd 

Batasan sistem struktur 

dan Batasan tinggi 

struktur, hn (m) 

Kategori desain seismic 

B C D E F 

SRPMK 8 3 5½ TB TB TB TB TB 

SRPMM 5 3 4½ TB TB TB TB TB 

SRPMB 3 3 2½ TB TB TI TI TI 

(Sumber: SNI 1726:2019) 

 

8. Gaya Lateral Ekivalen 

a. Periode fundamental struktur 

Periode fundamental atau waktu getar alami adalah kemampuan yang 

dibutuhkan struktur untuk gerakan bolak balik yang nilai gerakannya 

dipengaruhi oleh fungsi massa dan kekakuan. Nilai periode fundamental ini 

akan digunakan untuk mendapatkan beban gempa rencana. Nilai periode 

fundamental ini dibatasi oleh batas atas periode (periode maksimum) dan 
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batas bawah periode (periode fundamental pendekatan) sesuai dengan 

Persamaan 2.22. 

𝑇𝑎 = 𝐶𝑡  𝑥 ℎ𝑛
𝑥  ..........................................................................  (2.22) 

Dengan: 

hn = Ketinggian struktur  

Ct dan x = koefisien yang ditentukan pada Tabel 2.15 

 

Tabel 2.15 Nilai parameter periode pendekatan Ct dan x 

Tipe Struktur Ct x 

Sistem rangka pemikul momen di mana rangka 

memikul 100 % gaya seismik yang disyaratkan dan 

tidak dilingkupi atau dihubungkan dengan komponen 

yang lebih kaku dan akan mencegah rangka dari 

defleksi jika dikenai gaya seismik: 

  

• Rangka baja pemikul momen 

• Rangka beton pemikul momen 

0,0724 

0,0466 

0,8 

0,9 

Rangka baja dengan bresing eksentris 0,0731 0,75 

Rangka baja dengan bresing terkekang terhadap tekuk 0,0731 0,75 

Semua sistem struktur lainnya 0,0488 0,75 

(Sumber: SNI 1726:2019) 

 

Apabila dalam analisis struktur digunakan bantuan software untuk 

mendapatkan nilai periode fundamental struktur yang akurat sesuai massa 

dan kekakuan struktur, maka harus dilakukan pengecekan dengan 

Persamaan 2.23 terhadap batas atas periode. 

𝑇 = 𝐶𝑢 𝑥 𝑇𝑎  ...........................................................................  (2.23) 

Dengan nilai Cu  mengacu pada Tabel 2.16 
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Tabel 2.16 Koefisien batas atas periode yang dihitung 

Parameter percepatan respons spektral 

desain pada 1 detik, SD1 
Koefisien Cu 

 0,4 1,4 

0,3 1,4 

0,2 1,5 

0,15 1,6 

 0,1 1,7 
(Sumber: SNI 1726:2019) 

 

Maka periode desain yang digunakan harus memenuhi persyaratan pada 

Persamaan 2.24 sampai Persamaan 2.26 berikut: 

Jika Tc < Ta, T = Ta,  ...............................................................  (2.24) 

Jika Ta < Tc < CuTa, T = Tc,  ...................................................  (2.25) 

Jika Tc > CuTa, T = CuTa  ........................................................  (2.26) 

Dengan:  

T  = Periode Desain  

Tc  = Periode hasil analisa software  

Ta  = Batas Bawah/Minimum Periode 

CuTa  = Batas Atas/Maksimum Periode 

b. Gaya geser dasar seismik 

Gaya geser dasar seismik (V) dalam arah yang ditetapkan harus ditentukan 

sesuai dengan Persamaan 2.27. 

𝑉 = 𝐶𝑠 𝑥 𝑊  ............................................................................  (2.27) 

Dengan: 

Cs  = Koefisien respons seismik  

V = Gaya geser dasar seismik 

W  = Berat seismik efektif 

Untuk mendapatkan nilai koefisien respon seismik Cs, harus sesuai dengan 

Persamaan 2.28. 

𝐶𝑠 =
𝑆𝐷𝑆

(
𝑅

𝐼𝑒
)
  .................................................................................  (2.28) 
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Nilai Cs yang dihitung sesuai dengan Persamaan 2.28, tidak boleh kurang 

dari batas minimum sesuai dengan Persamaan 2.29 dan Persamaan  2.30, 

serta tidak boleh melebihi batas maksimum sesuai dengan Persamaan 2.31 

dan Persamaan 2.32. 

1) Batas minimum 

𝐶𝑠 = 0,044𝑆𝐷𝑆 𝑥 𝐼𝑒 ≥ 0,01 ...............................................  (2.29) 

Untuk struktur yang berlokasi di daerah di mana S1 ≥ 0,6g, maka Cs 

harus tidak kurang dari Persamaan 2.30. 

𝐶𝑠 =
0,5 𝑥 𝑆1

(
𝑅

𝐼𝑒
)

 .........................................................................  (2.30) 

2) Batas maksimum 

Untuk T ≤ TL 

𝐶𝑥 =
𝑆𝐷1

𝑇(
𝑅

𝐼𝑒
)
  ...........................................................................  (2.31) 

Untuk T > TL 

𝐶𝑠 =
𝑆𝐷1 𝑥 𝑇𝐿

𝑇2(
𝑅

𝐼𝑒
)

  .......................................................................  (2.32) 

c. Distribusi vertikal gaya gempa statik  

Distribusi gaya seismik lateral (Fx) di sebarang tingkat harus ditentukan dari 

Persamaan 2.33 dan faktor distribusi vertikal ditentukan dengan persamaan 

3.34.  

𝐹𝑥 = 𝐶𝑣𝑥 𝑥 𝑉  ..........................................................................  (2.33) 

𝐶𝑣𝑥 =
𝑤𝑥 𝑥 ℎ𝑥

𝑘

∑ 𝑤𝑖 𝑥 ℎ𝑖
𝑘𝑛

𝑖=1

  ....................................................................  (2.34) 

Dengan: 

Cvx  = Faktor distribusi vertikal 

V = Gaya lateral desain total atau geser di dasar struktur 

wi  dan wx  = Bagian berat seismik efektif total struktur (w) yang 

ditempatkan atau dikenakan pada tingkat i atau x 

hi dan hx  = Tinggi dari dasar sampai tingkat i atau x  

k = Eksponen yang terkait dengan periode (T) struktur 
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Nilai k berdasarkan periode (T) struktur sebagai berikut: 

a. Untuk nilai T ≤ 0,5 detik, maka nilai k = 1 

b. Untuk nilai T ≥ 2,5 detik, maka nilai k = 2 

c. Untuk nilai 0,5 < T < 2,5 detik, nilai k ditentukan dengan interpolasi 

linier dengan Persamaan 2.35. 

𝑦 = 𝑦1 + (𝑦2 − 𝑦1𝑥
𝑥−𝑥1

𝑥2−𝑥1
)  ............................................  (2.35) 

d. Distribusi horizontal gaya geser statik tiap lantai 

Geser tingkat desain seismik disemua tingkat (Vx) harus ditentukan sesuai 

dengan Persamaan 2.36. 

 𝑉𝑥 = ∑ 𝐹𝑖
𝑛
𝑖=𝑥   ...........................................................................  (2.36) 

Dengan: 

Vx  = Gaya geser tingkat desain gempa disemua tingkat 

Fi   = bagian dari gaya geser seismik (V) pada tingkat ke-i  

9. Penskalaan Gaya Gempa Dinamik Terhadap Statik 

Berdasarkan SNI 1726:2019 Pasal 7.9.1.4.1 bahwa, jika hasil analisa untuk gaya 

geser dasar dan analisis ragam (Vt) kurang dari 100% dari gaya geser (V) yang 

dihitung melalui metode statik ekivalen, maka gaya tersebut harus dikalikan 

dengan Persamaan 2.37. 

Skala gaya gempa =
𝑉

𝑉𝑡
  ...............................................................  (2.37) 

Dengan: 

V = Gaya geser dasar statik ekivalen 

Vt = Gaya geser dasar dari hasil analisis ragam/gaya geser dasar dinamik 

2.2.6 Penampang retak 

Retakan diperkirakan akan terjadi yang disebabkan oleh beban terfaktor, 

oleh karena itu walaupun terjadi retakan struktur harus tetap bertahan. Untuk 

mengantisipasinya, maka nilai momen inersia pada komponen struktur 

nonprategang harus diturunkan atau direduksi. Nilai faktor reduksi momen inersia 

untuk elemen nonprategang dapat dilihat pada Tabel 2.17 Momen inersia pada level 

beban terfaktor. 
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Tabel 2.17 Momen inersia pada level beban terfaktor 

Bagian dan kondisi Momen Inersia Luas Penampang 

Kolom 0,70 lg 

1,0 Ag 

Dinding Tidak Retak 0,70 lg 

 Retak 0,35 lg 

Balok 0,35 lg 

Pelat datar dan slab datar 0,25 lg 

(Sumber: SNI 2847:2019) 

 

2.2.7 Mode ragam 

Pada saat perencanaan struktur, harus dilakukan pengecekan mode ragam 

pada model. Umumnya mode ragam 1 dan 2 akan terjadi translasi dan mode 3 rotasi. 

Jika rotasi terjadi pada mode 2, maka perlu dilakukan pengecekan ketidakberaturan 

torsi, dan jika rotasi terjadi pada mode 1 maka desain harus dilakukan perubahan, 

baik itu dengan menambahkan kekakuan struktur, merubah konfigurasi maupun 

jenis sistem struktur. 

2.2.8 Penentuan simpangan antar tingkat 

Berdasarkan SNI 1726:2019 Pasal 7.12.1 bahwa, simpangan antar tingkat 

desain (∆) dapat dihitung menggunakan Persamaan 2.38 dan tidak boleh melebihi 

simpangan antar tingkat izin (∆a) seperti didapatkan dari Tabel 2.18 Simpangan 

izin antar tingkat. 

𝛿𝑥 =
𝐶𝑑 𝑥 𝛿𝑥𝑒

𝐼𝑒
  ....................................................................................  (2.38) 

Dengan: 

Cd  = Faktor pembesaran simpangan lateral 

δx   = Perpindahan elastik yang dihitung akibat gaya gempa desain tingkat 

Ie  = Faktor risiko bangunan/faktor keutamaan Gedung 

  



 

28 

 

Tabel 2.18 Simpangan izin antar tingkat 

Struktur 
Kategori risiko 

I atau II III IV 

Struktur, selain dari struktur dinding geser 

batu bata, 4 tingkat atau kurang dengan 

dinding interior, partisi, langit-langit dan 

sistem dinding eksterior yang telah didesain 

untuk mengakomodasi simpangan antar 

tingkat. 

0,025hsx 0,020hsx 0,015hsx 

Struktur dinding geser kantilever batu bata 0,010hsx 0,010hsx 0,010hsx 

Struktur dinding geser batu bata lainnya 0,007hsx 0,007hsx 0,007hsx 

Semua struktur lainnya 0,020hsx 0,020hsx 0,020hsx 

(Sumber: SNI 1726:2019) 

 

Catatan: hsx adalah tinggi tingkat dibawah tingkat x 

2.2.9 Ketidakberaturan torsi 

Ketidakberaturan torsi merupakan suatu jenis ketidakberaturan horizontal 

yang dapat diketahui dari terjadinya perbedaan yang signifikan antara simpangan 

antar lantai tingkat maksimum pada sebuah ujung struktur dengan simpangan antar 

lantai tingkat rata-rata dikedua ujung struktur. Tentunya hal ini diperlukan perhatian 

mendalam karena bangunan yang mengalami torsi berlebih sangat tidak aman 

apabila terjadi gempa. 

2.2.10 Gaya dalam 

Gaya dalam merupakan gaya yang bekerja pada elemen struktur bangunan 

akibat adanya beban. Gaya dalam ini terdiri dari gaya geser, momen, dan gaya 

aksial. Pada perencanaan elemen struktur bangunan baik itu pondasi, kolom hingga 

balok harus mampu menahan gaya dalam tersebut untuk menghindari terjadinya 

keruntuhan pada bangunan.  

2.2.11 Sistem isolasi 

Gagasan di balik konsep dari base isolation sangat sederhana, dengan 

memisahkan antara struktur atas dan dasar bangunan yang berhubungan dengan 

tanah, sehingga gerakan tanah tidak secara langsung ditransfer ke struktur atas. 

Dalam 20 tahun terakhir ini, ada beberapa perkembangan yang cukup signifikan 

dalam rekayasa kegempaan salah satunya adalah konsep isolasi seismic. Negara-
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Negara dengan resiko tinggi terhadap gempa seperti Jepang, Turki, Italy, Portugal, 

USA, Iran, China, Selandia Baru, dan Taiwan telah banyak menggunakan sistem 

ini. Bangunan atau struktur dari komponen horizontal pergerakan tanah akan 

dipisahkan oleh sistem ini dengan menyisipkan bahan isolator yang memiliki 

kekakuan horizontal yang relatif kecil antara bangunan atas dengan pondasinya. 

Sehingga percepatan gempa yang bekerja pada bangunan menjadi lebih kecil. Pada 

sistem isolator, ragam getar pertama bangunan hanya menimbulkan deformasi 

lateral, sedangkan bagian atas akan berperilaku sebagai rigid body motion. Ragam 

getar yang lebih tinggi yang menyebabkan deformasi pada struktur adalah 

orthogonal terhadap ragam pertama dan gerakan tanah. Sehingga ragam-ragam 

getar ini tidak ikut berpartisipasi didalam respons struktur, atau dengan kata lain 

energi gempa tidak disalurkan ke struktur bangunan (Naeim dan Kelly, 1999).  

Pada gempa kuat, periode alamiah bangunan lebih besar (umumnya antara 

2 s/d 3,5 detik) yang diakibatkan oleh isolator dengan kekakuan horizontal yang 

relatif kecil. Percepatan gempa pada periode ini akan relatif kecil, khususnya pada 

tanah keras. Percepatan pada struktur bangunan akan direduksi oleh isolator. 

Namun, sebaliknya perpindahan pada bangunan akan mengalami peningkatan yang 

disebabkan oleh isolator ini. Sistem isolasi juga dilengkapi dengan elemen-elemen 

yang mampu mendissipasi energi untuk membatasi perpindahan sampai pada batas 

yang dapat diterima. Disamping itu, setelah terjadinya gerakan seismik, sistem 

isolasi juga memiliki kemampuan untuk kembali pada posisi semula. Sedangkan 

pada gempa kecil atau akibat angin, kekakuan horizontal dari sistem isolator harus 

memadai, agar tidak menimbulkan getaran yang menyebabkan ketidaknyamanan 

penghuninya (Kelly, 2001). Saat ini terdapat berbagai macam sistem base isolation 

yang digunakan, berikut adalah macam-macam sistem base isolation: 

1. Elastomeric Based System 

Elastomeric Based System ini bahannya berupa karet alam dengan 

menambahkan pelat baja di tengahnya. Sistem ini tidak berpengaruh pada 

pergerakan orang di dalam bangunan tersebut, tidak berpengaruh pada gaya 

angin atau gaya gempa yang rendah. Sistem ini tidak dapat berpindah tempat 

dan dapat di kontrol setiap saat. Karakteristik dan cara kerja dari sistem ini 
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adalah menggabungkan pergerakan horizontal dan vertikal yang dapat bergerak 

kuat. Berikut adalah jenis dari alat ini: 

a. Low Damping Natural dan Synthetic Rubber Bearings  

b. Lead Plug Bearings  

c. High Damping Rubber Bearings 

2. Isolation System Based on Slidings 

Secara konseptual, sistem geser sangat sederhana dan dapat didekati secara 

teoritis. Suatu lapisan didefinisikan sebagai koefisien gesek yang akan 

mereduksi percepatan-percepatan pada nilai tertentu dan gaya yang dihasilkan 

juga terbatas pada koefisien gesek dikalikan berat. Sistem geser (sliding) murni 

akan menyebabkan perpindahan (displacement) tak terhingga, dengan batas atas 

sepadan dengan pergeseran tanah maksimum untuk suatu koefisien gesek 

mendekati nol. Suatu struktur dengan sistem slip nongeser bisa kembali ke 

posisi semula setelah terjadi gempa. Kurangnya gaya pemulih (restorative) bisa 

diperbaiki dengan menggunakan isolator yang dikombinasikan dengan tipe-tipe 

yang lain yang memiliki gaya pemulih atau dengan menggunakan permukaan 

bantalan yang tidak datar, seperti permukaan bantalan yang berbentuk bola.  

a. Elecricite-de-France System  

b. EERC Combine System  

c. The TASS System  

d. Resilient-Friction Base Isolation System  

e. Friction Pendulum System 

3. Spring-Type System  

Ada beberapa alat yang menggunakan pegas-baja (steel springs) tetapi 

umumnya pemanfaatannya untuk isolasi permesinan cukup aman. Kelemahan 

utama dari pegas-baja adalah karena bersifat fleksibel pada kedua arah (vertikal 

dan horizontal). Redaman yang kecil pada pegas akan sering bergerak pada 

beban layan. 

4. Sleeved-Pile Isolation System  

Fleksibilitas disediakan oleh pin di ujung elemen struktur seperti tiang, yang 

mana memungkinkan bangunan bergeser atau melemahkan tingkat pertama dari 
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bangunan. Elemen-elemen ini memberikan fleksibilitas tetapi tidak menyerap 

redaman, atau ketahanan pada beban layan dan pemakainnya digunakan 

bersamaan dengan alat lain yang memiliki fungsi yang sama. 

5. Rocking System 

Sistem Rocking isolation adalah suatu keadaan khusus disipasi energi yang 

tidak sesuai dengan definisi isolation dengan mengijinkan perpindahan lateral. 

Sistem ini digunakan dalam struktur langsing dan prinsip dasarnya adalah 

karena suatu getaran, periode dari respon meningkat dengan meningkatkan 

amplitudo getaran. Hal ini menyebabkan efek periode berkala. Berat dari 

struktur memiliki kemampuan memikul beban layan. Redaman dapat 

ditingkatkan dengan baut atau kantilever-kantilever baja. 

2.2.12 High damping rubber bearing 

High damping rubber bearing (Gambar 2.5) merupakan alat anti seismik 

yang dikembangkan dari karet alam yang mempunyai kekakuan horizontal yang 

relatif kecil dan materialnya dicampur dengan extra fine carbon block, oil atau 

resin, serta bahan pengisi lainnya meningkatkan redaman antara 10% - 20% pada 

shear strain 100% dengan modulus geser soft (G = 0,4 MPa) dan hard (G = 1,4 

MPa). Bantalan pada sistem isolasi seismik harus didesain dengan teliti untuk 

memastikan agar bangunan yang diterima tetap berdiri saat dan setelah gempa 

terjadi.  

 

 

Gambar 2.5 High Damping Rubber Bearing (HDRB) 

(Sumber: Katalog bridgestone, 2020) 
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Berdasarkan penelitian yang dilakukan oleh Syahnandito et.al (2020) 

menggunakan base isolation dengan tipe High Damping Rubber Bearing (HDRB). 

Dari penelitian tersebut didapatkan base isolatoion tipe High Damping Rubber 

Bearing (HDRB) ini dapat mereduksi gaya geser dasar dari 1470,725 ton menjadi 

1286,071 ton. Berdasarkan penelitian yang dilakukan oleh Samsya (2017) 

menggunakan base isolation dengan tipe HDRB didapatkan bahwa base isolation 

dengan tipe High Damping Rubber Bearing (HDRB) ini dapat mereduksi drift 

sebesar 63,63% pada arah x dan 68,18% pada arah y. Base isolation tipe High 

Damping Rubber Bearing (HDRB) ini juga dapat meingkatkan level kinerja 

bangunan yang sebelumnya dengan level kinerja IO (Immediate occupancy) 

menjadi B (Operational). 

Sistem isolasi harus direncakan untuk bisa menahan perpindahan 

maksimum (DM) yang ditentukan menggunakan property batas atas dan batas 

bawah yang bekerja pada arah yang paling menentukan dari respon horizontal. 

Perpindahan maksimum bisa dihitung menggunakan persamaan 2.39. 

𝐷𝑀 =
𝑔 𝑥 𝑆𝑀1 𝑥 𝑇𝑀

4 𝑥 𝜋2 𝑥 𝐵𝑀
  ...............................................................................  (2.39) 

Dengan:  

g  = percepatan gravitasi  

SM1  = Parameter percepatan spectral gempa maksimum periode 1 detik 

TM  = Periode efektif struktur dengan isolasi seismic 

BM  = Koefisien numerik terkait redaman efektif yang nilainya didapat pada Tabel    

 2.19 Faktor redaman, BM  
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Tabel 2.19 Faktor redaman, BM 

Redaman efektif, 𝛽 

(Presentase dari redaman kritis) 
Faktor BM 

≤ 2 0,8 

5 1,0 

10 1,2 

20 1,5 

30 1,7 

40 1,9 

≥ 50 2,0 

(Sumber: SNI 1726:2019) 

 

Sifat geser HDRB bergantung pada regangan geser. Ketergantungan 

regangan geser dari masing-masing property dinyatakan pada Tabel 2.20 Nilai G, 

u dan 𝛽. 

 

Tabel 2.20 Nilai G, u dan 𝛽 

Property Rumus G, u dan 𝛽 

XO.3R 

 (0,1 ≤ 𝛾 ≤ 3,0) 

𝐺(𝛾) = 0,0255𝛾4 − 0,2213𝛾3 + 0,7283𝛾2 − 1,1028 +

  0,8703)  

𝑢(𝛾) = −0,0087𝛾3 − 0,0262𝛾2 − 0,0105𝛾 + 0,272) 

β(𝛾) = −0,005𝛾3 + 0,015𝛾2 − 0,006𝛾 + 0,166  

XO.4S 

 (0,1 ≤ 𝛾 ≤ 2,7) 

𝐺(𝛾) = 0,054𝛾4 − 0,416𝛾3 + 1,192𝛾2 − 1,583𝛾 +

  1,145)  

𝑢(𝛾) = −0,0132𝛾3 − 0,0401𝛾2 − 0,0190𝛾 + 0,4001) 

β(𝛾) = −0,007𝛾3 + 0,020𝛾2 − 0,009𝛾 + 0,236 

XO.6R  

(0,1 ≤ 𝛾 ≤ 2,7) 

 

𝐺(𝛾) = 0,620 × (0,1364𝛾4 − 1,016𝛾3 + 2,903𝛾2 − 3,87 +

    2,855)  

𝑢(𝛾) = 0,408 × (0,03421𝛾3 − 0,2083𝛾2 + 0,2711𝛾 +

     0,9028)  

β(𝛾) = 0,240 × (0,02902𝛾3 − 0,1804𝛾2 + 0,2364𝛾 +

     0,9150)  

(Sumber: Katalog bridgestone, 2017) 

 

Sifat geser bedasarkan tabel diatas harus ditentukan dengan Persamaan 

(2.40) sampai Persamaan (2.45) berikut: 
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1. Kekakuan efektif (Keff) 

 𝐾𝑒𝑓𝑓 =
𝐺 𝑥 𝐴

𝐻
 ...................................................................................  (2.40) 

2. Kekakuan pasca-hasil (K2) 

 𝐾2 = 𝐾𝑒𝑓𝑓(1 − 𝑢)  ........................................................................  (2.41) 

3. Kekakuan pasca-hasil (K1) 

 𝐾1 = 10 𝑥 𝐾2 .................................................................................  (2.42) 

4. Karakteristik kekakuan (Qd) 

 𝑄𝑑 = 𝑢 𝑥 𝐾𝑒𝑓𝑓 𝑥 𝐻 ........................................................................  (2.43) 

5. Perpindahan hasil (Dy) 

 𝐷𝑦 =
𝑄1

(𝐾2𝑥 10)−𝐾2
 .............................................................................  (2.44) 

6. Kekuatan hasil (Fy) 

 𝐹𝑦 = 𝑄𝑑 + 𝐾2 𝑥 𝐷𝑦  .......................................................................  (2.45) 

Dengan: 

G(γ)  = Modulus geser aktual  

u(γ)  = Kekuatan geser maksimum 

β(γ)  = Redaman efektif  

A = Luas rubber 

H = Ketebalan rubber 

2.2.13 Analisa statis nonlinier (metode puhsover) 

Metode statis nonlinier merupakan metode yang digunakan untuk 

mengetahui perilaku keruntuhan suatu bangunan dengan menggunakan beban statis 

yang ditingkatkan sampai struktur mencapai keruntuhan. Metode ini dikenal 

dengan metode pushover, dimana struktur akan diberikan suatu pola beban lateral 

statis yang ditingkatkan secara bertahap hingga beberapa elemen struktur 

mengalami leleh dan berdeformasi inelastic.  

Metode pushover ini betujuan untuk memperkirakan beban maksimum dan 

perubahan bentuk (deformasi) yang terjadi serta untuk mendapatkan informasi 

bagian mana saja yang kritis. Selanjutnya dapat diidentifikasi bahwa bagian-bagian 

tersebut memerlukan perhatian khusus untuk pendetailan atau stabilitasnya. Cukup 

banyak studi menunjukkan bahwa metode statis pushover dapat memberikan hasil 
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mencukupi (ketika dibandingkan dengan hasil metode dinamis nonlinier) untuk 

bangunan regular dan tidak tinggi.  

Hubungan antara perpindahan lateral pada puncak bangunan (D) dan gaya 

geser dasar (V) digambarkan dalam suatu kurva yang menggambarkan kapasitas 

struktur disebut dengan kurva kapasitas (capacity curve). Untuk mengetahui 

perilaku struktur yang ditinjau terhadap intensitas gempa yang diberikan, kurva 

kapasitas ini kemudian dibandingkan dengan tuntutan (demand) kinerja yang 

berupa response spektrum berbagai intensitas (periode ulang) gempa. Kurva 

pushover dapat digambarkan secara kualitatif kondisi kerusakan yang terjadi pada 

level kinerja yang ditetapkan agar orang awam mempunyai bayangan seberapa 

besar kerusakan itu terjadi kepada bangunan. 

2.2.14 Metode kurva kapasitas 

Terdapat dua buah grafik pada kurva kapasitas yang disebut dengan 

spektrum, yaitu spektrum kapasitas dan spektrum demand seperti pada Gambar 2.6. 

 

Gambar 2.6 Titik kinerja 

(Sumber: Samsya, 2017) 

 

1. Kurva kapasitas 

Hubungan yang menggambarkan kapasitas struktur berupa hubungan gaya 

dorong total (base shear) dan perpindahan lateral struktur (biasanya ditetapkan 

pada atap/ puncak bangunan) disebut dengan spektrum kapasitas (Capacity 

spectrum). Spektrum kapasitas diperoleh dari kurva kapasitas yang didapatkan 

Sa 

Sd 

Demand spectrum 

Titik kinerja (Performance point) 

Capacity spectrum 
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dari hasil analisis pushover dan dinyatakan dalam satuan gaya (kN) dan 

perpindahan (m).  

Kurva kapasitas menggambarkan kekuatan struktur yang besarnya sangat 

bergantung pada kemampuan momen dan deformasi dari masing-masing 

elemen struktur. Untuk membuat kurva ini, caranya adalah dengan memberikan 

gaya dorong kepada struktur secara bertahap kemudian mencatat hubungan 

antara base shear dan perpindahan atap akibat beban lateral yang dialami oleh 

struktur dengan pola tertentu seperti pada Gambar 2.7. 

 

 

Gambar 2.7 Kurva kapasitas 

(Sumber: Samsya, 2017) 

 

2. Demand spectrum 

Demand spectrum menggambarkan besarnya demand (tuntuan kinerja) yang 

diakibatkan oleh gempa dengan periode ulang tertentu. Pada umumnya yang 

diperoleh dari spektrum respons elastis dinyatakan dalam satuan percepatan, Sa 

(m/detik2) dan periode struktur, T (detik). Ketika gempa besar, terjadi 

plastifikasi dibanyak tempat, oleh karena itu diperlukan untuk membuat 

spectrum demand dengan memperhatikan redaman (dumping) yang terjadi 

karena plastifikasi. Untuk memberikan gambaran yang jelas bagaimana sebuah 

bangunan merespon beban gempa adalah dengan menyajikannya dalam bentuk 

grafis seperti pada Gambar 2.8. Perencana dapat merencanakan berbagai 

skenario kekuatan struktur yaitu dengan cara mengganti kekakuan dari beberapa 

komponen struktur kemudian melihat kinerjanya akibat beberapa level demand 

(tuntutan) yang diinginkan secara cepat dalam sebuah grafik. 
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Gambar 2.8 Beberapa titik kinerja dalam satu grafik dalam CSM 

(Sumber: Samsya, 2017) 

 

3. Titik kinerja 

Titik kinerja merupakan gambaran dari suatu kondisi dimana kapasitas gempa 

dari struktur sama dengan gempa yang akan terjadi pada bangunan dan titik 

dimana kurva kapasitas berpotongan dengan kurva respon spektrum didapat 

melalui proses pengecekan kinerja yang bertujuan memastikan bahwa 

komponen struktural dan nonstruktural tidak mengalami kerusakan di luar 

batasan yang telah ditentukan. Gaya dan deformasi setiap elemen dihitung 

terhadap peralihan tertentu dititik control yang disebut sebagai target peralihan 

dengan notasi δt dan dianggap sebagai perpindahan maksimum yang terjadi saat 

bangunan mengalami gempa rencana (Vicky, 2013).  

2.2.15 Konsep level kinerja 

Tujuan dari dibuatnya peraturan adalah untuk menjamin keselamatan 

penghuni dan untuk menghindari atau mengurangi kerusakan atau kerugian nyawa 

maupun harta benda terhadap gempa yang mungkin terjadi. Walaupun demikian, 

prosedur yang digunakan dalam peraturan tersebut tidak dapat secara langsung 

memperlihatkan kinerja bangunan terhadap gempa yang sebenarnya, dan kinerja 

tersebut tentu terkait dengan resiko yang dihadapi pemilik bangunan.  

Proses perencanaan tahan gempa berbasis kinerja dimulai dengan membuat 

model desain rencana bangunan kemudian menjalankan simulasi untuk mengetahui 

kinerjanya dalam berbagai kejadian gempa. Setiap simulasi akan memberikan 

informasi mengenai tingkat kerusakan, ketahanan struktur, sehingga dapat 

diperkirakan berapa besar keselamatan, kesiapan pakai dan kerugian harta benda 



 

38 

 

yang akan terjadi. Ada beberapa metode yang bisa digunakan untuk mengetahui 

kategori level kinerja struktur, yaitu metode spektrum kapasitas ATC-40 (1996) dan 

metode koefisien perpindahan FEMA 356 (2000). Pada penelitian ini digunkan 

metode metode spektrum kapasitas ATC-40  untuk mengetahui level kinerja dari 

struktur. 

1. Metode spektrum kapasitas ATC 40 

Konsep performance based seismic design adalah konsep yang digunakan untuk 

menetapkan tingkat kinerja (performance level) yang diharapkan setelah 

struktur diberikan beban pushover dengan intensitas tertentu. Menurut ATC – 

40, kinerja bangunan terhadap beban pushover yang diberikan dibagi menjadi 

6 kategori level kinerja struktur yaitu: 

a. SP–1 (Immediate occupancy). Apabila diberikan beban pushover¸ 

kerusakan struktural yang terjadi hanya sedikit. Karakteristik dan kapasitas 

sistem yang menahan gaya vertikal lateral pada struktur masih sama seperti 

sebelum diberikan beban pushover arah x.  

b. SP–2 (Damage control). Dalam kategori ini, permodelan pada bangunan 

gedung dengan beban pushover dengan rencana nilai yang peluang 

dilampauinya dalam rentang masa layan gedung (50 tahun adalah 10%). 

c. SP–3 (Life safety). Apabila diberikan beban pushover maka terjadi 

kerusakan komponen struktur dan non struktur mulai dari kecil hingga 

tangkat sedang, kekakuan berkurang, tetapi masih mempunyai ambang yang 

cukup terhadap keruntuhan. Komponen nonstruktur masih ada tetapi tidak 

berfungsi. Bangunan bisa dipakai lagi jika sudah dilakukan perbaikan pada 

kerusakan. 

d. SP–4 (Limited safety). Kondisi bangunan tidak sebaik level life safety dan 

tidak seburuk level structural stability, termasuk ketika level life safety tidak 

efektif atau ketika hanya beberapa kerusakan struktur kritis yang dapat 

dikurangi. 

e. SP–5 (Structural stability). Level ini merupakan batas dimana struktur 

sudah mengalami kerusakan yang parah. Terjadi kerusakan pada struktur 
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dan non struktur. Struktur tidak mampu lagi dalam menahan gaya lateral 

karena penurunan kualitas. 

f. SP–6 (Not considered). Pada kategori ini, struktur sudah dalam keadaan 

runtuh sehingga hanya dapat dilakukan evaluasi seismik dan tidak dapat 

dipakai lagi.  

ATC–40 juga memberikan batasan rasio drift yang dievaluasi pada performance 

point. Parameter yang digunakan dalam menentukan performance level 

menurut ATC–40 ini adalah maksimum total drift dan maksimum inelastic drift 

yang disajikan pada tabel 2.21 Batasan drift ratio. 

 

Tabel 2.21 Level kinerja dengan batasan 

Parameter 
Immediate  

Occupancy 

Damage  

Control   

Life 

Safety 

Structural  

Stability 

Max. total drift 

(Xmax/H) 
0,01 0,01 – 0,02 0,02 0,33 Vi/Pi  

Max. inelastic drift 0,005 
0,005 – 

0,015 

no 

limit 
no limit 

(Sumber: ATC-40, 1996) 

 

Untuk nilai maximum total drift dan maximum inelastic drift dapat dihitung 

menggunakan Persamaan 2.46 dan Persamaan 2.47. 

Max. total drift  = 
𝐷1

𝐻𝑡𝑜𝑡𝑎𝑙
  ................................................................... (2.46) 

Max. inelastic drift = 
𝐷𝑡−𝐷1

𝐻𝑡𝑜𝑡𝑎𝑙
   .................................................................. (2.47) 

Dengan: 

Dt  = Displacement atas (paling atas) 

D1  = Displacement lantai 1 
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BAB III 

METODOLOGI PENELITIAN 

3.1 Diagram Alir Perencanaan 

Berikut adalah tahapan-tahapan penelitian dalam Tugas Akhir ini, 

diGambarkan dalam diagram alir pada Gambar 3.1.  

 

Gambar 3.1 Diagram alir penulisan skripsi/tugas akhir 

 

Pengumpulan Data Mulai 

Permodelan Struktur Base 

Isolator 

Kontrol 

Desain 

Permodelan Struktur Fixedbase 
Analisa Struktur 

Fixedbase 

Analisa Struktur Base 

Isolator 

Analisa Struktur  

Pushover 

 

Perbandingan Hasil 

Analisa 

 

Kesimpulan Selesai 

Ya 

Tidak 

Data Sekunder 

Data Primer 
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3.2 Data Perencanaan 

Pada sub bab ini akan dijelaskan mengenai data yang digunakan dalam 

perencanaan untuk penulisan Tugas Akhir ini. Berikut merupakan data yang 

digunakan: 

3.1.1 Data umum 

Nama gedung : Sapadia Hotel 

Fungsi : Hotel 

Jumlah lantai : 7 Lantai 

Tinggi tiap lantai : Lantai 1 (5 m), Lantai 2 – 7 (4 m) 

Tanah dasar : Tanah Sedang (Lampiran V hal. 146) 

Lokasi : Latitude (8°35'39.4"S) 

Longitude (116°05'50.2"E) 

  Lokasi penelitian dapat dilihat pada Gambar 3.2.  

 

  

Gambar 3.2 Lokasi penelitian 

(Sumber: Maps, 2023) 

 

3.1.2 Spesifikasi Material 

1.  Beton 

 Mutu beton (F’c) : 30 MPa 

 Elastisitas beton : 𝐸𝑐 = 4700 𝑥 √𝐹′𝑐  

𝐸𝑐 = 4700 𝑥 √30  = 25742,9602 MPa 

 Berat jenis beton : 24 kN/m3 

 Angka poison (v) : 0,2 

Lokasi Penelitian 
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 Modulus geser (G) : 𝐸𝑐

2𝑥(1+𝑣)
 = 

25742,9602

2𝑥(1+0,2)
 = 10726,2334 MPa 

2.  Baja tulangan lentur BJTS 420A 

 Kuat leleh (Fy) : 420 MPa 

 Kuat tarik (Fu) : 525 MPa 

 Elastisitas baja : 200000 MPa 

 Berat jenis baja : 78,50 kN/m3 

3.   Baja tulangan geser BJTS 280 

 Kuat luluh (Fy) : 280 MPa 

 Kuat tarik (Fu) : 350 Mpa 

 Elastisitas baja : 200000 MPa 

 Berat jenis baja : 78,50 kN/m3 

3.1.3 Data geometri bangunan 

Data geometri bangunan yang digunakan pada penelitian ini bisa dilihat 

pada Gambar 3.3 sampai Gambar 3.6. 

 

 

Gambar 3.3 Denah lantai 1-7 

(Sumber: AutoCAD, 2023) 
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Gambar 3.4 Denah atap 

(Sumber: AutoCAD, 2023) 

 

 

Gambar 3.5 Potongan melintang 

(Sumber: AutoCAD, 2023) 
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Gambar 3.6 Potongan memanjang 

(Sumber: AutoCAD, 2023) 

 

3.3 Preliminary desain 

Desain awal pada struktur Gedung Sapadia Hotel mengacu pada SNI 

2847:2019. Penjabaran tentang bagaiamana menentukan dimensi dari struktur 

meliputi kolom, balok dan pelat pada Gedung Sapadia Hotel telah dibahas pada bab 

dua. 

 

3.4 Analisa Pembebanan 

Analisa pembebanan pada struktur gedung ini menggunakan acuan 

berdasarkan peraturan SNI 1727:2020 tentang Beban Desain Minimum dan Kriteria 

Terkait Untuk Bangunan Gedung dan Struktur Lain. 

1. Beban mati  

Beban mati yang digunakan untuk pembebanan pada struktur gedung ini adalah 

keseluruhan pembebanan pada struktur seperti kolom, balok dan pelat yang 

diperhitungkan berdasarkan SNI 1727:2020 kemudian dilakukan permodelan 
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pada ETABS v.18 yang akan melakukan perhitungan otomatis untuk berat dari 

seluruh komponen struktur bangunan. 

2. Beban mati tambahan 

Beban mati tambahan yang digunakan untuk pembebanan pada struktur ini 

seperti berat mati tambahan lantai, beban mati tambahan atap dak, beban mati 

tambahan dinding bata pada balok, beban mati tambahan dinding bata tangga 

pada balok, beban mati tambahan pada tangga, beban pada berat lift yang sudah 

tercantum pada Tabel 2.4 Rekapitulasi beban mati tambahan pada bab dua. 

a. Beban mati tambahan pada pelat lantai 

- Keramik (+ screed/adukan semen) = 1,50 kN/m2 

- Berat plafond dan penggantung  = 0,18 kN/m2 

- Instalasi ME dan plumbing = 0,25 kN/m2 

Total Beban mati tambahan pada pelat lantai = 1,93 kN/m2 

b. Beban mati tambahan pada pelat atap 

- Berat waterproofing  = 0,63 kN/m2 

- Berat plafond dan penggantung = 0,18 kN/m2 

- Instalasi ME = 0,20 kN/m2 

Total beban mati tambahan pada pelat atap = 1,01 kN/m2 

c. Beban mati tambahan pada tangga 

- Spesi setebal 3 cm  = 0,42 kN/m2 

- Keramik setebal 1 cm = 0,17 kN/m2 

- Beban dinding pegangan handrail = 1,2 x 2,5/2 

 = 1,50 kN/m2 

Total beban mati tambahan pada anak tangga  = 2,09 kN/m2 

d. Beban dinding pasangan setengah bata lantai 1 setinggi 5 m 

- qSiDL = 5 x 2,5 = 12,5 kN/m  

e. Beban dinding pasangan setengah bata lantai 2 – 7 setinggi 4 m 

- qSiDL = 4 x 2,5 = 10 kN/m  

f. Beban mati tambahan akibat lift 

Pada penelitian ini, perencanaan beban lift menggunakan sistem lift tanpa 

ruang mesin dengan spesifikasi sebagai berikut: 
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- Berat lift = 2000 kg 

- Berat mesin = 258 kg 

- Kapasitas beban lift = 1000 kg 

- Ukuran car lift CW x CD x CH  = 1600 mm x 1400 mm x 2380 mm 

- Ukuran opening OP x OPH = 900 mm x 2100 mm 

- Ukuran hoistway HW x HD = 2250 mm x 1800 mm 

- Tinggi maksimum operasional = 80 m 

Untuk spesifikasi lift yang lebih lengkap bisa dilihat pada lampiran 4 

halaman 145. 

Pu = Berat lift + Berat beban lift + Berat mesin 

 = 2000 + 1000 + 258 

 = 3258 kg = 32.58 kN 

3. Beban hidup 

Beban hidup yang digunakan untuk pembebanan pada struktur gedung ini 

sesuai dengan fungsi masing-masing ruangan sesuai dengan Tabel 2.5 

Rekapitulasi beban hidup pada bab dua sebagai berikut:  

a. Kamar  = 1,92 kN  

b. Koridor = 3,83 kN  

c. Atap = 0,96 kN + Hujan (0,1 kN) 

d. Tangga = 4,79 kN  

4. Beban gempa 

Analisa beban gempa dilakukan mengacu pada SNI 1726:2019 dan mengikuti 

langkah-langkah analisa beban gempa sesuai dengan pembahasan beban gempa 

pada bab dua. Untuk parameter keutamaan umum struktur yang digunakan pada 

penelitian ini adalah sebagai berikut: 

a. Fungsi bangunan = Gedung apartement/Hotel 

b. Kategori risiko bangunan = Risiko II (Tabel 2.6 BAB 2)  

c. Faktor keutamaan gempa  = 1 (Tabel 2.7 BAB 2) 

d. Jenis tanah = Sedang (SD) 
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3.5 Analisa Struktur Menggunakan ETABS 

Analisa struktur struktur dilakukan berdasarkan ketentuan yang ada pada 

SNI 1726:2019. Pertama akan dilakukan permodelan dengan software ETABS v.18 

dan menganalisa struktur fixed base kemudian melakukan kontrol desain berupa 

kontrol periode getar, mass ratio, dan drift. Apabila semua aspek dari kontrol desain 

sudah terpenuhi, selanjutnya dilakukan desain base isolator kemudian melakukan 

permodelan dan analisa berdasarkan SNI 1726:2019. Proses dalam analisa struktur 

menggunakan ETABS v.18 sebagai berikut: 

3.5.1 Permodelan grid 

Permodelan grid merupakan langkah awal dalam melakukan analisa 

menggunakan ETABS. Dalam permodelan grid perlu diperhatikan Gambar rencana 

atau denah yang akan digunakan dalam analisa, penggunaan sumbu arah x dan y 

harus sesuai dengan arah memanjang dan lebar bangunan yang direncanakan dan 

untuk tinggi bangunan atau ketinggian antara tingkat menggunakan story data. 

Adapun langkah-langkah permodelan grid data yaitu dengan cara klik kanan pada 

plan view → Add/modify grids → pada menu grid systems pilih Add new grid 

systems → kemudian mengisi kotak dialog seperti Gambar 3.7. Berikut merupakan 

langkah-langkah permodelan story data, klik kanan pada plan view → Add/modify 

grids → pada menu story data pilih Modify/show story data → kemudian mengisi 

kotak dialog seperti Gambar 3.8. 

 

 

Gambar 3.7 Permodelan grid 

(Sumber: ETABS, 2023) 
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Gambar 3.8 Permodelan story/ketinggian antar lantai 

(Sumber: ETABS, 2023) 

 

3.5.2 Mendefinisikan material  

Dalam permodelan ada dua material yang didefinisikan yaitu beton dan baja 

tulangan. Berikut merupakan cara mendefinisikan material: 

1. Untuk mendefinisikan mutu beton, pilih menu Define → Material properties 

→ Add new material → Concrete → kemudian mengisi dialog dengan data 

material rencana seperti pada Gambar 3.9 dan Gambar 3.10. 

 

 

Gambar 3.9 Material property data beton 

(Sumber: ETABS, 2023) 
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Gambar 3.10 Input material property data 

(Sumber: ETABS, 2023) 

 

2. Untuk mendefinisikan baja tulangan beton, pilih menu Define → Material 

properties → Add new material → Rebar → kemudian mengisi dialog dengan 

data material rencana seperti pada Gambar 3.11 dan Gambar 3.12. 

 

Gambar 3.11 Input property data baja tulangan 

(Sumber: ETABS, 2023) 
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Gambar 3.12 Input nilai Fy dan Fu baja tulangan 

(Sumber: ETABS, 2023) 

 

3.5.3 Mendefinisikan penampang struktur 

1. Membuat penampang kolom 

Pilih Section properties → Frame properties → pilih Add new property → pada 

kotak dialog Frame property shape type → pada Section shape pilih Concrete 

rectangular → pada jenis penampang beton pilih bentuk persegi Panjang seperti 

pada Gambar 3.13 dan Gambar 3.14.  

 

Gambar 3.13 Frame property shape type 

(Sumber: ETABS, 2023) 

 

Pada kotak dialog Frame section property data: 

- Property name: diisi sesuai dengan kode/ nama kolom 

- Material: pilih sesuai dengan mutu beton untuk kolom 

- Section dimensions: diisi sesuai dengan dimensi kolom 
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Gambar 3.14 Input dimensi kolom 

(Sumber: ETABS, 2023) 

 

Selanjutnya menginput momen inersia pada kolom yang telah dibuat, pilih 

Modify/show modifiers → memasukkan momen inersia untuk analisis elastis 

pada level beban terfaktor = 0,7 seperti pada Gambar 3.15 → OK.  

 

Gambar 3.15 Stiffness modification factor untuk kolom 

(Sumber: ETABS, 2023) 

 

Kemudian untuk menginput tulangan pada kolom, pilih Modify/show rebar → 

mengisi dialog seperti pada Gambar 3.16.  
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Gambar 3.16 Input tulangan kolom 

(Sumber: ETABS, 2023) 

 

- Design type: pilih P-M2-M3 untuk kolom 

- Rebar material: pilih material baja tulangan yang digunakan 

- Reinforcement configuration: pilih jenis kolom rectangular/persegi 

- Confinement bars: pilih Ties (jenis tulangan sengkang kotak  

- Check/design: pilih reinforcement to be designed  

- Clear cover for confinement bar: 40 mm tebal selimut beton minimum 

Pada bagian check/design, dengan memilih reinforcement to be designed berarti 

penulangan yang dihitung otomatis oleh ETABS sesuai dengan hasil luas 

tulangan yang diperlukan.  

2. Membuat penampang balok 

Untuk langkah-langkah pembuatan penampang balok sama dengan penampang 

kolom, kemudian pada kotak dialog Frame section property data. 

- Property name: diisi sesuai dengan kode/ nama balok 

- Material: pilih sesuai dengan mutu beton untuk balok 

- Section dimensions: diisi sesuai dengan dimensi balok 

Width untuk lebar balok dan depth untuk tinggi balok 
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Selanjutnya menginput momen inersia pada kolom yang telah dibuat, pilih 

Modify/show modifiers → memasukkan momen inersia untuk analisis elastis 

pada level beban terfaktor = 0,35 seperti pada Gambar 3.17 → OK. 

 

 

Gambar 3.17 Stiffness modification factor untuk balok 

(Sumber: ETABS, 2023) 

 

Kemudian untuk menginput tulangan pada balok, pilih Modify/show rebar → 

mengisi dialog seperti pada Gambar 3.18.  

 

Gambar 3.18 Input tulangan balok 

(Sumber: ETABS, 2023) 

 

- Design type: pilih M3 untuk balok 

- Rebar material: pilih material baja tulangan yang digunakan 

- Cover to longitudinal rebar group centered: 

Top bars: 60 mm 

Bottom bars: 60 mm 
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3. Membuat penampang pelat 

Pilih menu Define → Section Properties → Slab sections → Add new property 

→ memasukkan data berupa tebal pelat pada kotak dialog seperti pada Gambar 

3.19 → OK. 

 

 

Gambar 3.19 Input property data pelat lantai 

(Sumber: ETABS, 2023) 

 

Pada bagian general data: 

- Slab material: pilih F’c 30 MPa sesuai dengan data material rencana 

- Modelling type: pilih shell thin untuk model pelat yang digunakan 

3.5.4 Menggambar elemen struktur dan jenis tumpuan 

Untuk menggambar elemen struktur pada ETABS, kita bisa menggunakan 

toolbar yang sudah ada pada ETABS yang terletak pada sisi kiri windows. Berikut 

merupakan langkah-langkah dalam menggambar elemen struktur dan perletakan: 

1. Untuk menggambar elemen struktur (balok, kolom dan pelat) dengan cara 

memilih plan view → klik pada tools draw beam/column/brace → pilih 

property → pada kotak dialog properties of object, pilih property sesuai dengan 

elemen struktur yang akan digambar seperti pada Gambar 3.20. 
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Gambar 3.20 Properties of object 

(Sumber: ETABS, 2023) 

 

2. Pada lantai dasar diasumsikan tumpuan yang digunakan adalah tumpuan jepit. 

Karena tumpuan ini memiliki kemampuan untuk menahan momen, gaya 

vertikal dan gaya horizontal. Adapun langkah-langkah untuk memasukkan 

tumpuan jepit yaitu, aktifkan mode one story pada pojok kanan bawah jendela 

ETABS → pilih menu view → Set plan view → pilih base → OK → kemudian 

blok seluruh denah pada lantai base → pilih menu Assign → Joint → Restraints 

→ pada bagian fast restraints pilih tumpuan jepit → Apply → OK seperti 

Gambar 3.21. 

 

 

Gambar 3.21 Input tumpuan jepit 

(Sumber: ETABS, 2023) 

 

3.5.5 Mendefinisikan pola pembebanan 

Pembebanan yang digunakan dalam analisis ini terdiri dari beban mati 

akibat berat sendiri struktur, beban mati tambahan dan beban hidup. Untuk 

mendefinisikan pembebanan bisa dimulai dengan memilih menu Define → Load 

patterns → kemudian mendefinisikan pembebanan seperti pada Gambar 3.21. 
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Gambar 3.22 Input pola pembebanan 

(Sumber: ETABS, 2023) 

 

3.5.6 Input beban mati tambahan dan beban hidup 

1. Input beban terpusat/beban titik 

Pilih joint yang akan dimasukkan beban terpusat kemudian pilih menu Assign 

→ Joint loads → Forces → masukkan nilai beban terpusat seperti pada Gambar 

3.23 → Apply → Ok. 

 

 

Gambar 3.23 Input beban terpusat/beban titik 

(Sumber: ETABS, 2023) 

 

2. Input beban pada frame 

Pilih menu Select → Properties → Frame sections → pilih frame yang akan 

diinput beban → Select → Close. Kemudian pilih menu Assign → Frame loads 

→ Distributed → input beban seperti pada Gambar 3.24 → Apply → OK. 
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Gambar 3.24 Input beban pada frame 

(Sumber: ETABS, 2023) 

 

3. Input beban pada shell/pelat 

Pilih menu Select → Properties → Slab sections → pilih slab yang akan diinput 

beban → Select → Close. Kemudian pilih menu Assign → Shell loads 

→Uniform → input beban seperti pada Gambar 3.25 → Apply → OK. 

 

 

Gambar 3.25 Input beban pada shell/pelat 

(Sumber: ETABS, 2023) 

 

3.5.7 Diafragma 

Berdarkan SNI 1726:2019, analisis struktur harus memperhitungkan 

kekakuan relative diafragma dan elemen vertical sistem penahan gaya gempa. 

Diafragma untuk lantai tiap tingkat diasumsikan kaku. Selain sebagai persyaratan 

permodelan, diafragma lantai antar tingkat dan joint ini bertujuan untuk 

mendapatkan nilai masssa total aktual tiap lantai yang akan digunakan untuk 

menentukan berat total struktur dalam perencanaan beban gempa. Untuk menginput 
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diafragma pada lantai, pilih menu Select → Select → Properties → Slab sections 

→ pilih tipe pelat (pelat lantai dan atap) → Select → Close → kemudian pilih menu 

Assign → Shell → Diaphragms → pilih D1 → Modify/show definitions → pilih D1 

→ Modify/show diaphragms → pilih Rigid (kaku) pada dialog Rigidity seperti 

Gambar 3.26 → OK 

 

.  

Gambar 3.26 Data diafragma 

(Sumber: ETABS, 2023) 

 

3.5.8 Mendefinisikan mass source 

Mass source digunakan untuk menentukan jumlah massa yang dihitung oleh 

ETABS untuk menganalisis waktu getar, beban total untuk beban gempa dan 

sebagainya. Untuk mendefinisikan mass source pilih Define → Mass source → Add 

new mass source → kemudian akan tampil kotak dialog seperti pada Gambar 3.27. 

 

 

Gambar 3.27 Mendefinisikan mass source 

(Sumber: ETABS, 2023) 

Pada analisis ini digunakan mass source dengan specified load patterns 

dimana massa total didapat dari hasil input pembebanan tertentu dengan faktor 

pengali sesuai dengan SNI 1726:2019. Analisis menggunakan specified load 
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patterns ini dapat memberikan massa aktual yang direncanakan dalam pembebanan 

gempa sehingga ETABS akan otomatis menghitung massa perlantai sesuai dengan 

pola pembebanan yang telah didefinisikan. 

3.5.9 Mendefinisikan modal cases 

Modal merupakan analisis dinamik untuk mengetahui perilaku ragam gerak 

struktur disetiap modenya. Pilih menu Define → Modal Cases → Add new case → 

Pada maximum number of modes diisi dengan mode awal = 12 seperti pada Gambar 

3.28. Pada analisis ini memerlukan modal yang cukup agar tercapai massa ragam 

minimal 90% pada analisis gempa dinamik. Analisis statik pembebanan gempa 

mengikuti pola ragam gerak di mode awal, yang memberikan arah translasi 

dominan untuk kedua arah sumbu orthogonal. Apabila partisipasi massa ragam 

dengan 12 mode kurang dari 90%, maka bisa menambahkan jumlah mode agar 

partisipasi massa ragam tercapai. 

 

 

Gambar 3.28 Data modal case 

(Sumber: ETABS, 2023) 

 

3.5.10 Run analisis awal 

Run analisis dilakukan ketika modeling telah selesai dilakukan. Sebelum 

melakukan run analisis, terlebih dahulu dilakukan pengecekan terhadap model yang 

telah dibuat sebelumnya. Pilih menu Analyze → Check model → kemudian centang 

semua parameter yang akan dicek seperti pada Gambar 3.29 → OK. 
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Gambar 3.29 Pengecekan model 

(Sumber: ETABS, 2023) 

 

 Setelah itu, untuk menentukan mode analisis yang digunakan, pilih menu 

Analyze → Set active degrees of freedom → pilih Full 3D.→ OK. Kemudian untuk 

menentukan load case yang akan dijalankan pada analisis, pilih menu Analyze → 

Set loada cases to run → centang pada Calculate diaphragm centers of rigidity 

seperti pada Gambar 3.30→ Run now. 

 

 

Gambar 3.30 Set load case to run 

(Sumber: ETABS, 2023) 
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3.5.11 Analisis modal case 

Untuk melihat hasil analisis modal case pilih menu Display → Show tables 

→ Analysis result → Structure output → modal information → centang pada model 

participating mass ratios dan modal load participation ratios seperti pada Gambar 

3.31. 

 

 

Gambar 3.31 Display mode ragam 

(Sumber: ETABS, 2023) 

 

3.5.12 Berat seismik efektif 

Berat seismic efektif merupakan berat total dari penjumlahan beban mati 

struktur, beban mati tambahan, dan beban hidup. Untuk melihat berat seismic 

efektif, pilih menu Display → Show tables → Analysis result → Structure output 

→ Other output items → centang pada center of mass and rigidity seperti pada 

Gambar 3.32→ OK. 
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Gambar 3.32 Display berat seismik efektif 

(Sumber: ETABS, 2023) 

 

3.5.13 Pembebanan gempa statik ekivalen 

Untuk menambahkan beban gempa statik ekivalen melalui ETABS, terlebih 

dahulu unlock model ETABS karena sebelumnya telah dilakukan Run Analysis 

dengan cara mengklik ikon gembok pada toolbars seperti pada Gambar 3.33. 

 

 

Gambar 3.33 Unlock model 

(Sumber: ETABS, 2023) 

 

Kemudian pilih menu Define → Load patterns → tambahkan beban gempa 

statik arah x → kemudian pada Auto lateral loads pilih ASCE 7-16 seperti Gambar 

3.34 → Add new load → Modify lateral load → kemudian mengisi kotak dialog 

seperti pada Gambar 3.35 dibawah ini. Untuk beban gempa statik arah y caranya 

sama seperti menambahkan beban gempa statik arah x. 
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Gambar 3.34 Menambahkan beban gempa statik pada load patterns 

(Sumber: ETABS, 2023) 

 

 

Gambar 3.35 Menambahkan beban gempa statik ekivalen arah x 

(Sumber: ETABS, 2023) 

 

Setelah penambahan beban gempa statik arah x dan y selesai, selanjutnya 

dilakukan analisis dengaan cara pilih menu Analyze → set load cases to run → Run 

Now. Untuk memunculkan hasil dari analisis gaya gempa statik ekivalen, pilih 

menu Display → Show tables → Analysis result → Structure output → centang 

pada base rection seperti pada Gambar 3.36→ OK. 
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Gambar 3.36 Display base reactions 

(Sumber: ETABS, 2023) 

 

3.5.14 Pembebanan gempa dinamik response spectrum 

Pembebanan dengan menggunakan beban gempa response spectrum 

digunakan untuk melihat perilaku dinamik dari pola gaya geser bangunan tinggi. 

Pembebanan gempa dinamik respons spektrum dapat dianalisis secara langsung 

menggunakan program ETABS dengan membuat kurva repsons spektrum sesuai 

parameter spektral wilayah tempat gedung dibangun dan berdasarkan jenis 

tanahnya. Kurva respons spektrum desain adalah kurva hubungan antara fungsi 

percepatan spektral (Sa) terhadap periode (T). Kurva ini dilakukan untuk 

mendapatkan nilai percepatan tanah desain dengan analisis dinamik berdasarkan 

masing-masing modal yang ada seperti Gambar 3.37. 
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Gambar 3.37 Kurva respon spektrum desain 

(Sumber: SNI 1726:2019) 

 

Sebelum menambahkan beban gempa dinamik response spectrum, terlebih 

dahulu unlock model, setelah itu pilih menu Define → Functions → Response 

spectrum → pada choose functions type to add pilih ASCE 7-16 → Add new 

functions → kemudian akan muncul kotak dialog seperti pada Gambar 3.38 → 

masukkan parameter yang ada → OK. 

 

 

Gambar 3.38 Menambahkan beban gempa response spectrum 

(Sumber: ETABS, 2023) 
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Setelah beban gempa response spectrum ditambahkan, selanjutnya adalah 

mendefinisikan beban gempa dinamik dengan memilih Define → Load cases → 

Add new case → kemudian mengisi kotak dialog load case data seperti pada 

Gambar 3.39 → OK. 

 

 

Gambar 3.39 Menambahkan load case response spectrum 

(Sumber: ETABS, 2023) 

 

3.5.15 Kombinasi pembebanan 

Pilih menu Define → Load combination → Add new combo → memasukkan 

kombinasi pembebanan yang sudah ditentukan pada bab dua seperti Gambar 3.40. 

 

 

Gambar 3.40 Menambahkan kombinasi pembebanan 

(Sumber: ETABS, 2023) 
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Berdasarkan SNI 2847:2019 bahwa kekuatan desain yang disediakan oleh 

suatu komponen struktur, sambungannya dengan komponen struktur lain, dan 

penampangnya, sehubungan dengan lentur, beban normal, geser, dan torsi, harus 

diambil sebesar kekuatan nominal dihitung sesuai dengan persyaratan dan asumsi 

dari standar yang dikalikan dengan faktor reduksi kekuatan ϕ. Untuk menambahkan 

faktor reduksi kekuatan pada ETABS, pilih menu Design → Concrete frame design 

→ View/revise preferences seperti pada Gambar 3.41. Kemudian menambahkan 

desain kombinasi untuk analisis concrete frame dengan memilih menu Design → 

Concrete frame design → select design combinations → pindahkan kombinasi pada 

list combinations yang akan dicek ke kotak design combinations sebelah kanan 

seperti pada Gambar 3.42→ kemudian design and check. 

 

 

Gambar 3.41 Concrete design prefrences 

(Sumber: ETABS, 2023) 
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Gambar 3.42 Design load combinations selection 

(Sumber: ETABS, 2023) 

 

3.5.16 Output-output 

1. Waktu getar alami 

Untuk memunculkan nilai waktu getar alami pada ETABS, pilih menu Display 

→ Show tables → Structure output → Modal information → centang pada 

Table: Modal participating mass ratio → OK. Kemudian muncul tabel seperti 

pada Gambar 3.43. 

 

 

Gambar 3.43 Output waktu getar alami 

(Sumber: ETABS, 2023) 
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2. Mode ragam 

Untuk melihat nilai mode ragam, caranya sama seperti pada waktu getar alami 

karena berada pada tabel yang sama seperti pada Gambar 3.44. 

 

 

Gambar 3.44 Output mode ragam 

(Sumber: ETABS, 2023) 

 

3. Kontrol simpangan antar tingkat 

Untuk memunculkan nilai simpangan maksimum tiap tingkat, pilih menu 

Display → Story response plots → Formatted seperti pada Gambar 3.45→ OK. 

 

 

Gambar 3.45 Output simpangan 

(Sumber: ETABS, 2023) 

 

4. Ketidakberaturan torsi 

Untuk memunculkan nilai dari ketidakberaturan torsi yang sudah otomatis 

dihitung oleh ETABS, pilih menu Display → Show tables → Analysis result → 
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Joint output → Displacement → centang pada Table Story max over avg drift 

→ OK. Muncul kotak dialog seperti pada Gambar 3.46. 

 

 

Gambar 3.46 Output torsi 

(Sumber: ETABS, 2023) 

 

5. Gaya dalam 

Untuk memunculkan nilai dari gaya dalam yang dihasilkan oleh ETABS, pilih 

Display → Force/stress diagram → Frame/pier/spandrel/link forces seperti 

pada Gambar 3.47 → OK. 

 

 

Gambar 3.47 Output gaya dalam 

(Sumber: ETABS, 2023) 
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3.6 Perencanaan Base Isolator Tipe HDRB 

3.6.1 Perencanaan dimensi dan desain properties base isolator 

1. Menganalisis struktur gedung menggunakan ETABS v.18 untuk mendapatkan 

berat total struktur dan gaya aksial terbesar pada kolom 

2. Menentukan nilai dari parameter yang akan digunakan, meliputi periode target, 

parameter percepatan spectra, koefisien redaman dan modulus geser 

3. Menentukan dimensi base isolator 

4. Menghitung perpindahan maksimum 

5. Menentukan kuat geser maksimum dan modulus geser actual 

6. Menghitung nilai kekakuan 

7. Menghitung karakteristik kekuatan 

8. Menghitung nilai perpindahan pasca-hasil 

9. Menentukan nilai redaman efektif 

Hasil analisis parameter desain penampang base isolator tipe HDRB di atas 

akan dimasukkan ke dalam ETABS untuk dilakukan analisis, berikut bisa dilihat 

gambar dari base isolator tipe HDRB pada Gambar 3.48. 

 

 

Gambar 3. 48 Penampang base isolator 

(Sumber: Sketchup, 2023) 

 

3.6.2 Penginputan base isolator 

Berikut merupakan langkah-langkah penginputan base isolator pada model. 

1. Mendefinisikan link/support properties 

Pilih menu Define → Section properties → Link/support properties→ Add new 

property → kemudian isi dialog sesuai dengan data rencana base isolator yang 

digunakan seperti pada Gambar 3.49. 

800 mm 

1150 mm 

422,2 mm 
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Gambar 3.49 Link/suppport properties 

(Sumber: ETABS, 2023) 

 

Kemudian memasukkan memasukkan nilai pada linear properties pada U1, U2, 

dan U3 dengan cara pilih modify/show for U1, U2, dan U3 lalu mengisi dialog 

seperti pada Gambar 3.50 sampai Gambar 3.52. 

 

 

Gambar 3.50 Link/support properties pada U1 

(Sumber: ETABS, 2023) 
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Gambar 3.51 Link/support properties pada U2 

(Sumber: ETABS, 2023) 

 

 

Gambar 3.52 Link/support properties pada U3 

(Sumber: ETABS, 2023) 

 

2. Mendefinisikan spring properties 

Pilih menu define → Spring properties → Point spring → Add new property → 

kemudian mengisi data pada dialog seperti pada Gambar 3.53. 
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Gambar 3.53 Point spring properties 

(Sumber: ETABS, 2023) 

 

3. Memasukkan base isolator pada model 

Aktifkan mode One Story pada bagian kanan bawah ETABS v.18 → pilih menu 

View → Set plan view → pilih base → Ok → blok setiap kolom berdasarkan 

model base isolator → pilih menu Assign → Joint → Spring → pilih base 

isolator yang telah dibuat sebelumnya → OK seperti pada Gambar 3.54. 

  

Gambar 3.54 Joint assignment spring 

(Sumber: ETABS, 2023) 
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3.7 Analisa Pushover 

Apabila hasil dari analisa dan kontrol pada desain semua elemen sudah 

memenuhi. Selanjutnya akan dilakukan analisa pushover untuk mengetahui 

perilaku keruntuhan bangunan dengan memberikan beban dorong yang 

ditingkatkan secara bertahap sampai bangunannya runtuh. Berikut merupakan 

tahapan dalam analisa pushover. 

1. Menentukan titik kontrol sebagai acuan pada saat pemberian beban dorong dan 

untuk memonitor besarnya perpindahan struktur. Rekaman besarnya 

perpindahan titik kontrol dan gaya geser dasar digunakan untuk Menyusun 

kurva pushover.  

2. Membuat kurva pushover berdasarkan berbagai macam pola distribusi gaya 

lateral terutama yang ekivalen dengan distribusi dari gaya inertia, sehingga 

diharapkan deformasi yang terjadi hampir sama atau mendekati deformasi yang 

terjadi akibat gempa. Oleh karena sifat gempa adalah tidak pasti, maka perlu 

dibuat beberapa pola pembebanan lateral yang b erbeda untuk mendapatkan 

kondisi yang paling menentukan. 

3. Estimasi besarnya perpindahan lateral saat gempa rencana. Titik kontrol 

didorong sampai taraf perpindahan tersebut, yang mencerminkan perpindahan 

maksimum yang diakibatkan oleh intensitas gempa rencana yang ditentukan. 

4. Mengevaluasi level kinerja struktur ketika titik kontrol berdasarkan spektrum 

kapasitas, merupakan hal utama dari perencanaan barbasis kinerja. Komponen 

struktur dan aksi perilakunya dapat dianggap memuaskan jika memenuhi 

kriteria yang dari awal sudah ditetapkan, baik terhadap persyaratan deformasi 

maupun kekuatan. 

 

3.8 Hasil Analisa 

Setelah hasil dari analisa pushover didapatkan, selanjutnya hasil tersebut 

dapat dievaluasi dengan membandingkan pada kedua struktur fixed base dan 

struktur base isolator. Pembahasan hasil evaluasi dilakukan berdasarkan pada bab 

sebelumnya.  


